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Preface
Thoroughly read this manual before using your instrument or accessories. The manual described

below are provided to help you operate the instrument safely. Read each chapter thoroughly

before attempting to operate the instrument and always operate the spectrophotometer in

accordance with the instruction.

This manual covers the characteristics, structural and function of the instrument, and instrument

operational process and maintenance of the atomic absorption spectrophotometer (hereafter this

text will be abbreviated as instrument).

The company retains the right to modify and improve the products described in this document

without prior notice. The company may update the manual because of instrument update. Please

make the object as standard if any difference exist between instruments and manual content.

The company does not make warranty of any kinds, explicit or acquiescent guarantees for the

accuracy, reliability and content of the document except acceptable laws stipulate otherwise.

The company retain the right to revise or retract the document at any time without prior notice.

It is hoped that the readers will kindly point out possible errors and omissions in the manual.
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Safety Precautions
ELECTRICITY SAFETY

1.1 Check the power supply voltage, confirm that it meets the power supply voltage value required

by the instrument before insert the power plug of the instrument into a new electric socket.

Make sure that phase wire, neutral wire and ground wire are connected correctly. Ground wire

in the electric socket must be well grounded.

1.2 Check the power cord regularly and replace or repair the power cord with damaged insulation

in time.

1.3 The product is still connected to the grid power supply when the power switch is set to “off”.

Please do not dismantle the product shell without authorization, to avoid the danger of electric

shock to the human body. Please disconnect the power plug from the grid power supply before

disassembling the instrument.

1.4 Graphite furnace analysis requires the use of high-power electrical supply equipment, for

which customer need to contact a professional electrician for laboratory circuit modification

during installation. During daily use, users should not change the power supply line as well as

power supply mode, so as to avoid abnormal power supply or equipment operation failure,

which may cause danger.

GAS SAFETY

1.5 Regular leak inspections should be carried out on the gas supply pipelines and gas

connections, at least once every six months.

1.6 The most used gas for flame analysis in atomic absorption spectrophotometers is acetylene.

Acetylene is flammable and explosive. It is easy to generate metal acetylene when it contacts

with metal elements such as gold, silver, copper, and mercury. It may explode when exposed

to heat or vibration. Users must carefully grasp the characteristics of acetylene and the safety

requirements for storage, transportation and use, and operate in strict accordance with the

regulations.

1.7 Besides argon, hydrogen must be used to provide a reducing environment when the atomic

absorption spectrophotometer uses a small electrothermal atomization device for analysis.

Seeing that hydrogen is flammable and explosive, users must carefully grasp the

characteristics of hydrogen and the safety requirements for storage, transportation and use,

and operate in strict accordance with the regulations.

1.8 Combustible gas cylinders such as acetylene, hydrogen, etc. should be placed in the

instrument compartment or equipped with a dedicated gas cylinder cabinet at a distance more

than 10m. The gas cylinder room is forbidden from all sources of fire and items that may cause
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sparks and flammable spontaneous combustion. Keep the room ventilated and cool.

Acetylene, hydrogen and other combustible gas cylinders are forbidden to place with oxygen

cylinders in the same room. Argon cylinders more than three meters away from the instrument

is exception. Protect the gas pipeline from collision, extrusion, baking and chemical corrosion.

1.9 High-pressure gas cylinders must be reliable fixed during use to ensure safety.

OPERATION SAFETY

1.10The instrument comprises high voltage modules. Private disassembly may cause gas leakage

and other hazards. It is forbidden to touch, disassemble, replace the internal components of

the instrument without permission.

1.11Some cathode metals of hollow cathode lamps can be harmful to human and pollute the

environment. Hollow cathode lamps with poison metals should be disposed properly and

cannot be discarded carelessly when the lamps are damaged or scraped.

1.12Since the analysis tail gas may contain volatile toxic substances, the instrument must be used

in a well-ventilated environment, and the operators must undergo strict operation training.

Solutions containing pollutants such as heavy metals and highly corrosive components can

poison the human body and pollute the environment. For this reason, those solutions should

be properly recycled and treated in accordance with the laboratory's toxic substance

processing methods. Do NOT dump them at will.

1.13During igniting, the surface of the atomizer and the adjacent area will generate high

temperature. The operator should not touch the flame atomizer system during the analysis

process (or within a short time after the analysis is completed) for fear of empyrosis or other

dangers.

1.14Since large current during the analysis process will cause elevated temperatures and high

luminance on the surface and adjacent area of graphite furnace tungsten wire electrothermal

atomizer, the operator should not touch the atomizer system or direct view the graphite

furnace during the analysis process (or within a short time after the analysis is completed) for

fear of empyrosis, retinal damage or other dangers.

1.15Do not apply graphite tubes and heating wire components from other manufacturers to our

products. The discrepancy of the tube contact surface and resistance will cause the damage of

the atomization system, and even cause safety hazards such as abnormal heating of the

instrument and fire on the electrical contact surface.

1.16Some models of instruments are equipped with a constant magnetic field background

correction device. An inter-field magnetic field still exist near the constant magnetic field

atomizer although the instrument switches off. Avoid using general iron and steel tools. Special

tools must be used for operation. Be careful not to bring items and equipment which are easily

magnetized, such as watches, pacemakers, etc., near the magnetic unit of the instrument.
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DATA SAFETY

1.17The computer configured with the instrument should be controlled to use USB to prevent

computer poisoning or data loss.

1.18It is strictly forbidden to use the dedicated computer for the instrument to surf the Internet,

install other program software from unknown sources, or use game floppy disks, CD-ROMs,

etc. to avoid the infringement of viruses on the computer and the system paralysis.

WARNING SYMBOLS

Operators must follow the instructions in the user manual or the warning information on the

instrument regardless of operating the instrument or maintaining or repairing the instrument. The

following is a list of warning symbols.

Hot surface Voltage, Be careful

Grounded terminal
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Chapter 1 Introduction
1.1 Instrument Characteristics

Atomic Absorption Spectrophotometer (AAS) is a kind of instrument for the inorganic analysis, and

the detectable elements are more than 70 kinds. It is widely used in environmental protection,

medicine, sanitation, metallurgy, geology and petrochemical industry fields for micro and trace

analysis.

1) The instrument is designed for air-acetylene flame method analysis, flame emission method

analysis and graphite furnace analysis etc.;

2) Support multi-attachment expansion, which can perform oxygen-enriched-air-acetylene

high-temperature flame method, hydride generation method analysis, etc.;

3) The software runs under Windows 7/Windows 10 operation system. It is simple to use with

friendly interface and high automation. The data can be export to Excel, Word etc.;

4) It adopts miniaturization gas circuit and control system. The structure is more stable and

reliable, and the security is high;

5) This instrument has eight lamp positions, two of them provide high performance HCL power

supply system (varies exist according to different configurations), which have higher intensity

and lower background. The light intensity of the hollow cathode lamp of these two positions is

about three to fifty times higher than that of the common ones, so it is helpful to improve the

performance of the instrument;

6) The reliable safety monitoring and protection system can realize a whole-process monitor of

the instrument supply system on-off or leakage and other sudden failures. It also has

automatic ignition, automatic setting of the acetylene flow and other functions. Multiple safety
automatic protection functions are also provided， such as gas leakage and air pressure

deficiency.

Note: Please DO NOT adjust, repair, modify, or replace the slit group and wavelength

scanning mechanism of the instrument, which are not operator accessible.

1.2 Instrument Structure

The instrument is mainly comprised of eight systems: Graphite furnace power supply system,

Light Source system, Atomization system, Optical system, Detector system, Gas Circuit system,

Circuitry system, Data Processing system and Background Correction system. (As shown in

Fig.1-1).
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Fig. 1- 1 Atomic Absorption Spectrophotometer

1) Light Source system: It is in the light chamber upper left of the instrument. Using hollow

cathode lamps (HCL) as light source, and support 8 lamp positions. High performance HCL is

also supported (varies exist according to different configurations).

2) Atomization system: It is provided at center part of the instrument. The AAS is equipped with

flame and graphite furnace integrated atomization, which can automatically switch and

optimize position.

3) Optical system: The optical system consisting of outer light path, C-T type grating

monochromatic, and back light path, which is in the upper right of the instrument, is controlled

by the computer.

4) Detecting system: The detecting system is constituted by a wide-spectrum, high-sensitivity

photomultiplier tube and an electrical signal detection and processing unit which is located at

the upper right of the instrument.

5) Gas Circuit system： It is adopted a miniaturization of gas path design, with fuel gas flow

automatic control and several safety protection functions located under the optical system.

The system is not marked in the figure 1-1.

6) Circuitry system：It is constituted by power unit, lamp and signal unit, motor control unit, gas

circuit control unit, etc. They are dispersing in the rear of instrument. The system is not

marked in the Fig. 1-1.

7) Data Processing system：The system is constituted by the microprocessor, the peripheral

computer system, operational software, and printer and so on, which is not marked in Fig. 1-1.
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8) Background Correction system：Deuterium lamp is installed in the light chamber upper left

the instrument. Self-absorption background correction is controlled by the circuitry system.

Varies exist according to different configurations and it is not marked in the Fig. 1-1.

9) Graphite Furnace Power system: An external instrument accessory, which is used to supply
high power for the instrument.

1.3 Working Principle

1.3.1 The Working Principle of the Instrument:

The light source is used to emit the characteristic spectral radiation of the element to be

determined, which will be absorbed by the ground-state atoms of the element to be determined in

the sample vapor generated by the flame atomizer or the graphite furnace atomizer. By measuring

the absorbed quantity of the characteristic radiation, the content of the element that be determined

will be calculated according to the function relation between the change of the light energy and the

concentration of the element to be determined (Beer’s law).

1.3.2 The Working Principle of Background Correction Device:

Even though the technology of the self-absorption effective background-correction and deuterium

background correction has utilized the different physic principle, for the correction background

absorption device, the working principle is the same----to utilize double beam of variety

characteristic produced against the different absorption of atomic spectral line and molecular

spectral line to deduct the background absorption signal so as to decrease the influence on the

atomic absorption signal.

Atomic spectral characteristic emitting line in the radiation light of hollow cathode lamp

(corresponding to the hollow cathode lamp wide pulse radiation during background correction of

self-absorption effect) is absorbed by the atomic vaporization of the element to be determined in

the sample, also absorbed by the coexistence matters vaporization, so the atomic absorption

signal plus the background absorption signal is generated, that is AA + BG. When the continuous

spectral radiation of the deuterium lamp (corresponding to the hollow cathode lamp narrow pulse

radiation during background correction of self-absorption effect) is passing through the sample, it

is absorbed by the coexistence matter in the sample to be determined to produce the background

absorption signal. Meanwhile, a little amount of the atomic absorption signal also exists at the

wavelength of the atomic characteristic spectral line, it is AA’ + BG’.

The light signals which two beams are alternately passed through the sample will go through the

detection system and data processing system of the instrument, and assume that the background

absorption signal produced by two beam light signals are equal with each other (BG = BG’),

therefore the net atomic absorption signal after the deduction with each other:

AA + BG – (AA’ + BG’) = AA – AA’.
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For more detailed operating principle of atomic absorption spectrum method, please refer to

relevant spectroscopic books.

1.3.3 Functions Association Diagram

The functions association between each system units is shown as Fig. 1-2.

Fig. 1- 2 Functions association diagram

1.4 Basic Safety Requirements for Electronical Protection

When the instrument is working in normal case, it should comply with GB 4793.1-2007

requirements.

 Shock proof type: Ⅱ class device.

 Shock proof grade: B type device.

 Harmful fluid proof grade: Common type.

 Working Mode: Intermittent operation.

1.5 Technical Index

1) Wavelength Accuracy and Wavelength Repeatability

Wavelength Accuracy: ≤±0.25 nm

Wavelength Repeatability: ≤0.15nm

2) Spectral Bandwidth: ≤±0.02 nm

3) Stability of Baseline

Static: Zero Drift of Baseline≤0.005Abs/30min, Baseline transient noise≤0.001Abs



Drawell International Technology Limited

- 5 -

Dynamic: Zero Drift of Baseline≤0.005Abs/10min, Baseline transient noise≤0.005Abs

4) Measurement repeatability (MR), Detection Limit (DI) and linearity error (LE):

Element: Cu; Measurement: Flame Method;

MR≤0.9%; DI≤0.007μg/mL, LE≤10%

Element: Cd; Measurement: Graphite Furnace Method;

MR≤3.6%; DI≤0.8pg, LE≤15%

1.6 Specifications Parameters

According to the differences of various models and suffixes, varies exist in different configurations

products.

 Wavelength Range: 190~900nm

 Light Source: Eight lamp position design

Automatically rotating light stand that can be automatic switch and optimize

Two lamp positions to support high-performance hollow cathode lamps

Each lamp position can be lighted and preheated optionally

 Beam-splitting System: C-T type monochromatic

Automatic peak search setting and scanning, automatic setting of slits and

energy, automatic wavelength optimization

Ruled Density: 1800 lines/mm; Blazed Wavelength: 250nm

Focal Length: 277mm

Spectral Bandwidth: 0.1nm, 0.2nm, 0.4nm,0.8nm and 1.6nm (debugging

slit) switching automatically

 Atomization System: The instrument is equipped with flame and graphite furnace integrated
atomization, automatic switching and optimizing position.

10cm all-titanium burner for air-acetylene flame, equipped with flame emission burner

Automatic ignition, equipped with high-precision mass flow control system, automatic gas flow

control and adjustment

Longitudinal heating graphite furnace system, temperature range from normal temperature to

3000℃, heating rate> 3000℃/s

The graphite furnace supports optical/constant voltage dual temperature control method,

supports ramp/step multi-stage heating method

The graphite furnace is equipped with independent control of internal gas/outer gas/small gas,

circulating water control and supporting detection system
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 Safeguard:

Real-time monitoring of flame status, air pressure, etc. Automatically shutting off the gas

circuit and alarm in abnormal status.

Automatically shutting off the gas circuit and alarm if ignition failure, gas leakage, flow control

error and other abnormal conditions occur.

For graphite furnace AAS, automatic electrical protection and alarm will be activated if the

graphite furnace heating program and furnace state, which is real-time monitoring, is

abnormal.

For graphite furnace AAS, automatic electrical protection and alarm will be activated if water

and air circuit control error, graphite tube installation abnormity, and temperature control

abnormity happen.

 Software Communication: Standard USB communication port

Intelligent operating software support by Win7/Win10

Automatic optimization of the instrument state with simple

operation. And multi-task analysis is supported

Automatically fit the working curve, reset the slope, and calculate

the concentration and sample content, etc.

Automatically calculate the average, standard deviation and

relative standard deviation. The measurement repeats 1-99 times.

Print test data or final analysis report. Edited by Excel or Word.

 Power Requirements: Instrument host: Monophase alternating current, 220V, average
power dissipation≤0.3kVA

Accessories Power: Monophase alternating current, 220V, peak power dissipation≤0.3kVA

 Dimension: Instrument host: 1020mm (L)530mm(W)500mm(H)

Accessories Power:350mm(L)490mm(W)430mm(H)

 Weight: Instrument host: 85kg; Accessories Power: 40kg

1.7 Warranty Description

Our goods come with guarantees of refund, repair or replacement. The factory is responsible for

free warranty fifteen months from date to delivery (including the quality objection period of three

months after delivery) in normal use. We have the right not to assume the warranty responsibility

under the following conditions:

1) The instrument cannot be restored or damaged due to unauthorized disassembly by the user.
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2) This instrument is a precision measuring instrument and is strictly prohibited from being

placed in a strongly corrosive gas, humid or dusty environment. Optical parts, electrical parts

and other elements suffer in deterioration, damage, etc. caused by contamination or

corrosion.

3) Damage to the instrument or elements due to violation of regulation, wrong operation or

improper handling.

4) Damage cause by irresistible factors.
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Chapter 2 Environment Requirements
2.1 Working Environment

1) Environmental Temperature: +10℃～+30℃, proper environmental temperature range:

+18℃～+25℃

2) Inside Relative Humidity Range: < 85%; Proper relative humidity range: < 70%; it is

recommended to install independent dehumidification equipment in humid climate areas.

3) Altitude：0-4000 m.

4) No strong magnetic field interference, no vibration that hinder the normal operation, no fire, no

electrical heating, and equipment easily generating electrical sparks.

5) Clean and dry in the room without dust and corrosive gases.

6) Lightning rod should be installed on the lab top. The place where it enters the ground should
be far from the working ground wire.

2.2 Transportation and Storage Condition

Rain, solarization and strong crash should be avoided during the transportation. The instrument

with original packing box should be kept well in the storage room before installation. The

environmental conditions for the transportation and storage should be as follows:

1) Temperature range: -40℃~55℃

2) Relative humidity range: ≤95%

3) Height of incline drop: 250mm.

2.3 Laboratory Conditions for Safety Operation

All the requirements mentioned in this section must be satisfied before the instrument is installed

and adjusted.
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Fig. 2- 1 Laboratory Switchboard and Socket Specifications for the instrument

2.3.1 Power Supply Requirements

2.3.1.1 Power and power supply

Main unit: monophase AC 220V±22V, 50Hz, service power≤0.3kW, regular power supply is

recommended.

Power accessories: Monophase AC 220V±22V, 50Hz, Peak Output≥5.5kW.

Air Compressor: AC220V±22V, single phase AC, 50Hz, 240 VA (It is suggested to be separated

with the power supply of main unit and computer).

Computer and Printer: Monophase AC 220V±22V, 50Hz, (Recommend to regulating power

supply)

Circulating Water Machine: Monophase AC 220V±22V, 50Hz, (Recommend to regulating power

supply)

2.3.1.2 Power supply connections

To provide power supply to the laboratory, please pay attention to the supply phase cables of big

power devices and producing strong magnetic field devices must be separated from cables used

for this instrument. The necessary circuit modification will be carried out when the power

accessories are installed. The laboratory switchboard and the socket specifications for the

instrument is shown in Fig.2-1.

2.3.1.3 Ground

To ensure the smooth working of the instrument and the safe operation, the ground wire of the

instrument must be connected to a metal plate of 1m2 areas, and the metal plate should be buried

1.5m under the ground. The grounding should be humidity and no rock. The ground resistance
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should not be greater than four.

2.3.2 Requirements of Gas Supply

2.3.2.1 Necessary gases

1) Compressed Air: The outlet pressure of the air compressor should be adjusted to 0.21MPa to

0.3MPa and should not less than 0.20MPa. Compressed air is supplied by cylinders or air

compressors.

2) Acetylene gas: It is supplied by the acetylene cylinder and used for flame analysis. The

specialized decompress adjustor and the safety shutoff valve must be provided. The outlet

pressure should between 0.06MPa～0.08MPa, and never less than 0.05MPa or larger than

0.1MPa. The purity of acetylene should be analytically pure (≥99.99%). Using general

industrial acetylene is strictly prohibited to avoid damage internal precision elements of the

instrument.

3) Argon: It is supplied by the argon cylinder and sued for graphite furnace analysis. The

decompression regulator is provided as standard accessory. The main gauge pressure range

is between 0~25MPa, and the sub-gauge pressure range is between 0~0.4MPa. The outlet

pressure should between 0.06MPa～0.08MPa, and never less than 0.05MPa or larger than

0.1MPa. The purity of acetylene should be analytically pure. (≥99.99%).

2.3.2.2 Storage requirements

1) The acetylene cylinder should be stored independently in a well-ventilated room and ensure

that NO fire source nearby! But the store place should nearby the laboratory.

Note: It is strictly prohibited to store the oxidation gas and the fuel gas sources in the
same room!

2) The air compressor and argon cylinders could be placed in laboratory.

3) All cylinders should be placed firmly and stable without declination.

2.3.3 Ventilation Requirements

1) When analyzing samples using the atomic absorption spectrometer, many gaseous matters

will be created, so it is the necessary to install the ventilation device in the laboratory.

2) The ventilation opening should be installed above the atomizer. The installation dimension

and method of the ventilation device refers to Fig.2-2.

3) Put a piece of paper at the ventilation opening, if it is sucked on the opening slightly, the

ventilation rate is favorable. The ventilation rate is neither too strong nor too weak. If it is too

strong, it will affect the stability of the flame, while the rate is too weak, it cannot exhaust the

gases well. The ventilation rate of the discharge fan should be 10~30 m3/minute, which

depends on the size, length and direction of the discharge pipe.
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4) The ventilation device should be made by metal materials rather than plastic to avoid

damaged by heating from instrument.

Fig. 2- 2 Installation of Ventilation Device

2.3.4 Requirement of Cooling Water

The cooling water is used for graphite furnace analysis by the instrument.

1. Provided by tap water or cooling circulating water machine, no-load flow≥5L/min, loaded

flow0.6L/min~2.0L/min;

2. The outlet of water should be equipped with a pipe joint that matches the outer

diameter of φ6mm pipeline, and the inner diameter should not less than φ3mm.

2.4 Other Requirements

1) Working bench

a) Dimensions of working bench should be: 250(L) * 110 (W) *70(H) cm

b) The work-bench should be firm and no deformation while load-bearing.

c) The surface of the working bench should be flat and covered by a shockproof or

corrosion-resisting plastic or rubber board.

d) When the instrument is putted on the work-bench, it is better to keep some space around

the instrument for making it easy to maintain the instrument.

2) This series instruments are integration precision instruments of optics, machinery and

electrons. Therefore, the operation environment should be clean and dust free. The room

temperature should be stable. It is necessary to install air-condition in the room.
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3) The laboratory for putting the atomic absorption spectrophotometer must be separated from

the chemistry laboratory to prevent the instrument from the etching of acid, alkali and other

corrosive gases, steam and smog.

4) To avoid virus damaging the computer system, strictly forbid people to view Internet or play

games on the specialized computer.

5) The indoor cleanliness of a laboratory that placing the instrument using graphite furnace for

trace or ultra-trace analysis is triter than normal laboratory. Generally, the indoor air pressure

should be positive, and the air should be filtered. Dustproof materials should be decorated on

the floor and wall to meet ultra-clean. When analyzing calcium, potassium, sodium,

magnesium, zinc and other elements that are extremely vulnerable to environmental pollution,

only laboratories decorated with inert plastic polytetrafluoroethylene can be used. To reach

accurate measurement results, operators must be especially careful when touching the

vessels containing samples and reagents to ensure that the samples to be tested are not

contaminated.
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Chapter 3 Installation and Inspection
3.1 Commodity Inspection

After the instruments are received, it is necessary to check and accept the goods immediately

according to the shipping documents. Make sure that the name and quantity of the goods comply

with the contract and transport invoices. Moreover, it is necessary to check whether the package

boxes are in good condition, if there is any apparent damage, negotiate it with the commodity

carrier and contact your local dealer immediately.

Note: Before the installation and acceptance of the instrument, the user must complete the
"Installation Confirmation Letter" and feedback the results. The installation can be carried
out after the confirmation is correct!

3.2 Unpacking

1) After unpacking the instrument, take out the technical documents and check whether the

spare parts are complete according to the packing list. At the same time, check whether the

instrument is damaged after the transportation. If there are any problems, inform the local

dealers immediately.

2) Read over the operation manuals of the instrument and get familiar with the principle,

structure and application of the instrument.

3) Prepare the working conditions and necessary laboratory devices according to the

requirements set forth in this manual and install the instrument according to this chapter.

4) Test the main performance of the instrument. The operations above should be carried through

under the directing of specialized engineer or the installer commissioned in writing.

3.3 Installation

3.3.1 Necessary Devices

1) Hollow cathode lamps: There are four HCLs (Cd, Cu, Hg, and Mn) equipped with the

instrument; they are mainly used for adjusting the instrument. User should purchase other

hollow cathode lamps according to the analytical purpose.

2) Analysis items: Users should prepare premium pure acid, standard solution, and other

supporting quantitative containers, pre-processing equipment, etc.

3) Prepare several plastic barrels with the volume of 5~10L to contain waste liquids and

deionized water. Pay great attention to make obvious marks on the barrels for different uses.

Moreover, you’d better not to use the glass container to contain the waste liquids.

4) Common tools: Except the standard screwdrivers and the internal hex wrenches equipped

with the instrument, the user should prepare several screwdrivers with various sizes, monkey
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wrenches and nipper pliers, and so on.

3.3.2 Installation of Instrument

1) Unpacking: Take out the main unit, all accessories and parts from the packing box and install

them in the laboratory.

2) Place the instrument: Put the main unit on the working bench, and make sure that all the

hold-down feet are firmly stand on the surface of the bench. Leave no less than 0.5m space

on the left and right sides of the table.

3) Place accessories: The computer (user-selected or self-configuration) should be placed on

the right side of the instrument. Power accessories of the instrument should be placed on the

left side of the instrument.

4) Instrument levelling: Adjust three rubber hold-down feet on the bottom of the main unit to

make the instrument stable and firm. If not so, adjust the three height-adjustable feet (There

are totally six feet, three of them are stationary) on the bottom of the main unit so that all six

feet are placed on the table to ensure the instrument balanced and firm.

3.3.3 Connection of the Main Unit and the Electric Circuit

After meeting the power supply requirements described in Chapter 2, the power supply and

communication of equipment, accessories and other equipment should be connected according to

the following requirements。

1) Instrument power: Located at the lower right conner of the back of the instrument. Checking

the power switch that is turned off, plug the cable on the power socket.

2) Computer Communication Socket: On the right side of the instrument, there is a Type B USB

socket, connect it to the computer with the computer communication cable.

3) Graphite Furnace Power: the instrument is equipped with graphite furnace power. The

high-current cables (2 in total, DO NOT twist them) are connected to the integrated atomizer

through the hole in the middle of the rear of the instrument. The communication cable of

graphite furnace is connected to the aviation plug on the lower right side of the rear of the

instrument. Make sure that the graphite furnace power (located on the left side of the power

supply) is switched off, then plug the power cable into the matching power socket.

4) Connection of Air Compressor/Water Circulating Machine: Connect the circuit of air

compressor or water circulating machine whether it is user-selected or self-configuration

according to the instruction manual provided with the instrument. It is recommended to be

separated from the power supply line of the instrument host and computer.

Note: The wiring of the internal electrical system of the instrument has been connected
before leaving the factory. Please do not change or disassemble the internal wiring without
any special circumstance!
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3.3.4 Installation of Flame Atomizer

The atomization system of the instrument is automatic position control so that it does not need to

adjust the front and back and up and down positions.

Flame atomization system consists of atomizing burner and gas supply system. Turn the button on

the atomizing burner to adjust the position of the burner slot to make it aligns the optical path.

Fig. 3- 1 Burner slot adjustment

Adjust method: Turn on HCL and adjust it to the correct position, put a piece of white paper above

the burner (shown as in Fig. 3-1) to observe the gathering light spot of the hollow cathode lamp,

and then move the burner to make the light spot exactly located on the burner slot. Parallel move

the paper and rotate the angle of the burner to make the light spot aimed at any position of the

burner slot.

3.3.5 Connections of Gas Pipes

The external gas supply connection sketches are shown in Fig. 3-2.

Note: The atomizer and internal gas pipes have already been connected before leaving
factory. DO NOT dismantle the internal pipes unless there are troubles in the instrument.

Fig. 3- 2 The gas pipes connections

3.3.5.1 Tube connection

The gas circuit interface panel is located on the right side of the instrument, and the joints from top

to bottom are AIR, C2H2, Ar, Water (In) and Water (Out).
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For the instrument, the user needs to connect all five joints according to the following guide:

a. Air-compressorPressure regulator FilterAIR inlet. Which are connected with φ6mm

(OD) blue PU tube.

b. Acetylene cylinderAcetylene filter C2H2 Joint. Which are connected withφ6mm (OD)

white PTFE tube.

c. Ar cylinderAr Joint. Which is connected withφ6mm (OD)black PU tube with suitable

length.

d. Circulating water effluentWater (In). Which is connected withφ6mm (OD) translucence

PU tube with suitable length.

e. Circulating backwaterWater (Out). Which is connected withφ6mm (OD) translucence PU

tube with suitable length.

3.3.5.2 Installation of air-compressor

1) Install the air compressor, filter and other components according to the air compressor

manual.

2) Be sure that the air compressor runs normally before it is connected to the gas control system.

① check whether the compressor can start normally after powering on. ② check if the

pressure regulator filter runs normally, and check whether the outlet pressure could be

adjusted to the expected value (generally 0.22MPa±0.02MPa).

Note: The pressure regulating filter is an automatic drain type. When the water
accumulation in the filter reaches a certain level, it will automatically drain, and the valve
will automatically close after draining.

3.3.5.3 Installation of acetylene source

Be sure to read the Safety warning in the foreword of this manual.

1) The acetylene cylinder should be placed outside of the laboratory, with the good ventilation.
The connection piping to the laboratory must be qualified. Place a fire warning notice at the

acetylene source and provide a fire extinguisher there. The acetylene cylinder should be

placed vertically and firmly to avoid falling down.

2) Acetylene cylinder must be equipped with special pressure regulator. Use the specialized

tools to open or close the main valve of the acetylene cylinder (adjustable wrenches and other

tools is prohibited).

3) The tempering stop valve should be equipped at the outlet of the acetylene cylinder pressure

regulator.

4) The outlet pressure of acetylene cylinder pressure reducing valve should be adjusted to

0.08MPa±0.01MPa. A new cylinder should be replaced when the total pressure≤0.3MPa.
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3.3.5.4 Installation of argon source

1) Commonly argon source is stored in cylinders. A new cylinder should be replaced when the

total pressure≤0.5MPa.

2) The argon cylinder can be placed near the instrument workbench, which does not affect the

operation of the instrument and is safe and stable.

3) Install the oxygen/argon pressure reducing valve at the outlet of main valve. Adjust the outlet

pressure at 0.25MPa±0.01MPa;

4) The argon gas pipeline should be kept clean to prevent blockage of the gas circuit

components.

3.3.5.5 Installation of water circulating machine

1) The water circulating machine should possess functions of cooling and circulation, and the

no-load running flow≥5L/min;

2) Copper pipe joints and ball valve joints of the cooling water circulating machine that be

connected with the outlet and return of the instrument” SX-1800 cooling water circulating

machine” should be switch to them provided by the instrument. Shown as Fig.3-3.

3) If users equip the water circulating machine, the selection of the joint specifications between

the water inlet/outlet of the circulating water machine and the water inlet/outlet of the

instrument as well as the matching pipelines need to be solved by the user. Meanwhile, please

be sure to meet the requirements of the instrument end interface (outer diameter φ6mm

pipeline) and load operation Water flow requirements (≥1.0L/min).

Fig. 3- 3 Joints of Cooling Water Circulating Machine
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3.3.5.6 Connections of waste liquid piping

Fig. 3- 4 Connections of Waste Liquid Pipes

The waste liquid nozzle of the instrument is at the front and bottom of the atomizer mist chamber

on the front of the instrument. One end of the waste liquid pipe has been installed on the waste

liquid nozzle of the instrument, and the other end is cut to a suitable length and then connected to

the nozzle on the water seal. Fix the water seal group on the edge of the workbench and pour

enough water to isolate the inside of the atomizer from the outside atmosphere. Connect a section

of waste liquid pipe at the nozzle under the water seal to extend it into the waste liquid bucket

(provided by the user), but do not insert into the liquid surface, and do not insert the waste liquid

tube directly into the laboratory waste liquid without a water seal. As shown in Fig. 3-4.

NOTE: To avoid flashback, explosion or gas leakage, make sure that the water seal must be
in good condition when analyzing with the flame operation!!!

3.3.5.7 Inspection of leakage

After connecting the gas piping of the flame atomization system, check the pipeline, joints, valves

and other links for leaks before the formal start-up operation.

1) Inspection of Gas Leakage: Check the gas leakage with soap water. For leaks, the cause

should be found out and re-sealed. In particular, check whether the explosion-proof plug at

the rear of the fog chamber of the atomizing burner is well sealed, otherwise it is easy to

flash back when the flame is ignited

NOTE: Keep the spare explosion-proof films well for the future use.

2) Inspection of Water Leakage: After using a colling circulating water machine to supply

water, casually observe whether the water pipes, joints, and valves of the atomization

system on the front of the instrument are dripping and leaking. For drips, corresponding
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measures should be taken according to specific reasons to re-sealing.

NOTE: For air leaks or water leaks, please inspect again after the cause is found out.

3.4 Acceptance

After the installation of the instrument according to the above requirements was done, the

acceptance inspection can be made afterwards. Before proceeding with the acceptance check,

read the operation manual carefully to get familiar with the functions of every control and the

operations of the instrument. After then the instrument can be powered on. Unqualified operators

can never be allowed to operate the instrument. DO NOT change the instrument software and

parameter files randomly; otherwise, the operating troubles maybe occurred.

3.4.1 Requirements of Acceptance

1) Acceptance Conditions: The instrumental acceptance should be in accord with the

requirements of the working environment conditions mentioned in Chapter 2. Otherwise,

the severe environmental conditions may cause the accidental failure of the instrument or

get unsatisfied determination result.

2) Attentions: The standard solution used in the acceptance test should be prepared

immediately. If the storage time is too long, the concentration will have a large error. In

addition, prevent contamination caused by various factors when preparing standard

solutions to avoid abnormal results

3.4.2 Methods of Acceptance

The instrument should be warm-up for 30min before the acceptance procedure.

The acceptance should be carried out according to the following conditions and methods

3.4.2.1 Wavelength Accuracy and Repeatability

Requirements: Wavelength indication error does not exceed ±0.25nm, and wavelength

repeatability≤0.15nm.

Conditions：Use Hg hollow cathode lamp to check the wavelength of 253.7nm, 536.1nm,871.6nm,

with current of 3mA,width of the spectral bands of 0.2nm.

Method: Select the element of Hg; go into the instrumental condition page. Set spectral

band-width as 0.2nm, select Hg lamp location number and then input the above three wavelengths

respectively and click the “Auto-wavelength” button. The software will automatically seek the peak

position and show the wavelength value. Repeat each wavelength operation three times; get the

average value as wavelength accuracy, the difference value between maximum value and

minimum value as wavelength repeatability.

3.4.2.2 Spectral Bandwidth

Requirement: The deviation of spectral bandwidth does not exceed ±0.02nm
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Conditions: Use Cu hollow cathode lamp to check the wavelengths of 324.7nm; with the wide

pulse lamp current of 3mA, spectral bandwidth of 0.2nm.

Method: Select the element of Cu, wait until the instrument and the lamp runs stabilized. Set

spectral bandwidth as 0.2nm and then scan the spectral line of 324.7nm. Measure the half

band-width and its deviation should not more than±0.02nm.

3.4.2.3 Baseline Stability

Requirement: a. static baseline drift≤0.005Abs/30min, instantaneous noise≤0.001Abs

b. dynamic baseline drift≤0.005Abs/15min, instantaneous noise≤0.005Abs

Conditions: Use Cu hollow cathode lamp to check the wavelength of 324.7nm; Wide pulse lamp

current: 3mA, Spectral band-width: 0.2nm.

Methods: Warm up the instrument for 30min, and then find out the maximum energy. Click the

stability icon on the toolbar, baseline stability window will be shown. Set the time length as

30minutes, damping constant as 0.5s, and then start the measurement. This is static baseline

stability. The dynamic baseline stability means that repeating the above operation after igniting the

flame on the condition of setting the time length as 15 minutes, damping constant no more than 2s.

The baseline drift value and maximum instantaneous peak-peak value (instantaneous noise) from

both two methods should match the standard.

3.4.2.4 Characteristic Concentration, Detection Limit, Sensitivity, Linearity Error and
Repeatability of Cu with the flame method.

Requirements: Detection limit≤0.007µg/ml, characteristic concentration≤0.04µg/ml/1%,

sensitivity≥0.11Abs/(µg/ml), linearity error≤0.9%, repeatability≤0.9%.

Conditions: Cu, 324.7nm ； Spectral bandwidth: 0.4nm; Damping constant≤2.0s; Other

parameters are adjusted to the best working condition.

Methods: Standard solution: Cu standard solution: (1.0, 3.0 and 5.0) μg/mL, use 0.5% HNO3

water solution as medium; Blank solution: 0.5% HNO3 water solution; Appropriate Atomization
Condition: Acetylene flow (1.2~1.5) L/min.

1) Select to measure the blank for 11 times, and input 1.0, 3.0, 5.0μg/mL in the standard sample

table, each standard sample would be measured 3 times.

2) After the measurement, the Characteristic Concentration and Detection Limit will be

calculated automatically. The slope value is sensitivity.

3) Then calculate the difference value between back calculation concentration and its truth-value

of calibration curve intermediate point (3.0μg/mL). And the percentage of the difference value

to truth-value is defined to be Linearity Error.

4) According to the same method above, measure the standard sample of 1.0μg/mL for 7 times.
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After the measurement, the Repeatability will be calculated automatically shown as relative

standard deviation.

3.4.2.5 Characteristic Quantity, Detection Limit, Sensitivity, Linearity Error and
Repeatability of Cd with the graphite furnace method.

Requirements: Detection limit≤0.8pg, characteristic quantity≤0.9pg, sensitivity≥0.005Abs/pg,

linearity error≤15%, repeatability≤3.6%.

Conditions: Cd, 228.8nm；Spectral bandwidth: 0.2nm; Damping constant≤0.5s; Sample 20µL,

Other parameters are adjusted to the best working condition.

Methods: Standard solution: Cd standard solution: (0.5, 1.0 and 3.0) ng/mL, use 0.5% HNO3

water solution as medium; Blank solution: 0.5% HNO3 water solution; Appropriate Atomization
Condition: Drying temperature (80~100) ºC keep 20~40 seconds, ashing temperature (200~300)

ºC keep 15~30 seconds, atomization temperature (2000~2500) ºC keep 3~6 seconds,

idle-running temperature (2200~2600) ºC keep 2~4 seconds, cooling 20~30 seconds.

1) Select to measure the blank for 11 times, and input 0.5, 1.0, 3.0ng/mL in the standard

sample table, each standard sample would be measured 3 times.

2) After the measurement, the Characteristic Concentration and Detection Limit will be

calculated automatically. The slope value is sensitivity.

3) Then calculate the difference value between back calculation concentration and its

truth-value of calibration curve intermediate point (1.0ng/mL). And the percentage of the

difference value to truth-value is defined to be Linearity Error.

4) According to the same method above, measure the Cd standard solution of 1.0ng/mL for 7

times. After the measurement, the Repeatability will be calculated automatically shown as

relative standard deviation.

3.4.2.6 Checking Lamp Position

Requirement: Eight lamp positions on the instrument light up normally.

Conditions: Current is 3mA of random elements.

Methods: The instrument has 8 lamp positions. Inspect each lamp position individually.

3.4.3 Processing of Acceptance Results

The purpose of acceptance is to check whether the quality of the instrument is reduced due to

transportation, storage, etc., resulting in failure to meet the requirements of use, and to find out the

reasons for the deterioration of performance for timely processing.

Inspection records should be made when the acceptance inspection is executed. If any function is

abnormal, please inform of the local dealers.

Note: The determination of characteristic concentration and detection limit has the great
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relations with the selection of analytical conditions and instrument parameters no mater
using flame method or graphite furnace method. When the abnormal results occur,
re-adjust height of atomization, atomization conditions and function parameters in order to
get better results.
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Chapter 4 Instrument Operational Process

4.1 Install the Operating Software

The AAS software is designed to run under Windows 7 or Windows 10 32/64 bit operating system.

4.1.1 Install the Software

1. Before the installation, please quit all the operating application programs. Run the ‘Setup.exe’

in the installer CD. When the guide run, users can follow the guide to complete the subsequent

steps. As shown in Fig. 4- 1.

Fig. 4- 1 Installation

2. Click ‘Next’ to enter the user info. Input the username and organization. As shown in Fig.4-2.

Fig. 4- 2 User Info
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3. Click ‘Next’ to enter the installation path window to set the installation path (It is recommended

to use the default installation path). As shown in Fig.4-3.

Fig. 4- 3 Installation Path Setting

4. Click ‘Next’ to enter the install affirming window. Click “Install” button to start the installation, as

shown in Fig.4-4.

Fig. 4- 4 Confirm Software Installation

5. After the installation, click ‘Finish’ to exit the install guide. As shown in Fig. 4-5.
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Fig. 4- 5 Confirm Software Installation

6. Double click the icon AAS on the desktop to run the software.

4.1.2 Files Saving and Backups

You can save and read the analytical missions created in AAS. The AAS mission files will be saved

as the format of ‘*.AAS’.

4.2 Notice of Instrument Operation

4.2.1 Preparation Before the Experiment

1) Read the safety instruction before operation.

2) Check every part of the instrument to be sure they are connected well (Such as main unit,

computer, accessories, gas cylinder and so on).

3) Prepare paper and ink box for the printer.

4) Turn on the exhaust system of working area.

5) Check the gas supply is sufficient; connect the power supply of the air compressor. Adjust the

reducing valve of air filter and acetylene cylinder to suitable pressure.

6) Install the lamp (There should be already have HCLs installed on the lamp holder before

turning on the instrument power) while wait for the air compressor to reach the working

pressure value.

7) Turn on the main unit.

8) For instruments with graphite furnace type, turn on the graphite furnace power supply

accessory first, and then turn on the host power supply.

9) For instruments with optional autosampler and other accessories, turn on the power supply of
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the corresponding accessories first, and then turn on the power supply of the host.

10) Double click the icon AAS on the desktop, enter the AAS software and start to operate the

instrument.

4.2.2 The Aftermath

1) After finished the analysis work, please inhale deionized water for minutes before shutting off

the flame.

2) Tighten the acetylene cylinder and turn off the air compressor.

3) The flame will extinguish when the residual gas in pipelines is depleted.

4) Click ‘Exit’ in the file menu of working window to quit the AAS software.

5) Turn off the main unit.

6) Turn off power supply of graphite furnace and all the other accessories.

7) Shut off exhaust system.

8) Turn off the computer and other equipment in the laboratory if they are not for other using.

4.3 The Basic Operation Flows

The basic operation process of analysis working is mainly as the following:
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Chapter 5 Software Operation
The software runs under Windows 7 or Windows10. Getting familiar with the Windows system is

better for you to use it.

5.1 Enter the Software

Switch on the computer, accessories, and main unit successively. Double click ‘AAS’ button on the

desktop to enter the main page of the software as shown in Fig. 5- 1.

Fig. 5- 1 Enter the AAS software

5.2 Software Control

The area above the main interface is operating control area. All functions of the AAS software

are offered here, and mainly contains menu bar and toolbar. You can complete all the

operating works relying on them.

5.2.1 Menu Bar

The Menu bar on the top of main interface includes four menus: File, Tool, Language, and Help

(As shown in Fig. 5- 2).

Tools Bar

Menu Bar

Working Area
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Fig. 5- 2 Menu bar

1. File menu

The ‘File’ menu contains all operations to the analysis task files (As shown in Fig. 5- 3)

‘New’: To design a new analysis task.

‘Open’: Open a saved analysis task file.

‘Close’: Close the current analysis task.

‘Save’: Save the current analysis task.

‘Save As’: Save the current analysis task at another path of the PC disk.

‘Print’: Print the current working page.

‘Print Preview’: Preview the pages which is going to be printed.

‘Print Setup’: Setup the printing parameters.

‘Exit’: Quit the AAS software.

2. Tool menu

The ‘Tool’ menu contains controls of analytical method and instrument parameters (As shown

in Fig. 5- 4).

Fig. 5- 3File menu
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Fig. 5- 4Tools Bar

‘USB Comm.’: Build the communication between the AAS software and main unit of the

instrument.

‘Analytical Method’: Edit the analytical methods. It is allowed to create new method, alter, or

delete the existing method.

‘Instrument Alignment’: Adjust the instrument parameters to get the optimizing operating

conditions.

‘Burner Alignment’: To adjust the parameters of the flame atomization.

‘Furnace Alignment’: To adjust the parameters of the graphite furnace atomization.

‘Base-line’: To measure the base line stability of the instrument.

3. Language menu

The user can switch the system language of AAS between English and Simplified Chinese. As

shown in Fig. 5- 5

4. Help menu

‘About AAS’: Show the version information of AAS.

5.2.2 Tool Bar

The tool bar is just under the menu bar in main interface. It includes several short cut buttons

which help to carry out the functions of the AAS software. As shown in Fig. 5- 6.

Fig. 5- 5 Language Menu
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Fig. 5- 6 Tools Bar

The functions of the short cut buttons in the tool bar are respectively as the following from left

to right:

‘Method’: Be same as the menu ‘Tool→Analytical Method’.

‘USB Connect’: Be same as the menu ‘Tool→USB Comm.’.

‘Measuring Parameters’: To setup the ‘Measurement Time’, ‘Delay Time’ and the
‘Damping Constant’.

‘Next Project’: Switch to the next project.

‘Instrument Alignment’: Be same as the menu ‘Tool→Instrument Alignment’.

‘Burner Alignment’: Be same as the menu ‘Tool→Burner Alignment’.

‘Sample Table’: To view and edit sample table.

‘Recalibrate’: Select a standard sample to check and reset the slope of calibration
curve.

‘Baseline’: Be same as the menu ‘Tool→Baseline’.

‘About AAS’: Be same as the menu ‘Help →AAS”.

5.3 Design of Analysis Task

Select the menu ‘File →New’ or click the button on the toolbar to enter the ‘Design of
Analysis Task’ window (As shown in Fig. 5- 7).
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Fig. 5- 7 Design of Analysis Task

In this page, the information about the analysis task can be edited, such as ‘Applicants’,

‘Laboratory Name’, ‘Operator’, ‘Batch NO.’, and ‘Analysis date’.

This instrument can carry out multi element analysis task. One analysis task can carry out the

determination of up to six element analysis items. In the item list, select the analysis method

and add items in the order of analysis successively. The columns from left to right in the item

list are the "analysis order", the measured "element", the "analysis method" and the

corresponding element "light position".

5.3.1 Select Method

Click the ‘Method’ button in Fig. 5- 7to enter the ‘Analytical Method’ window (As shown in Fig.

5- 8). If there was already exist an applicable analytical method in the methods list, just choose

it and then click ‘OK’. And if there is not, the user should click the ‘Create’ button to create new
method.

Mission information

Project List
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Fig. 5- 8 Analytical Method

5.3.2 Create New Method, Amend Method and Delete Method

Fig. 5- 9 Method

To create a new method, please click the ‘Create’ button in Fig. 5- 8 to enter the ‘Method’ window
(As shown in Fig. 5- 9).

To amend an existing method, please select the method in the methods table, and then click

the ‘Amend’ button in Fig. 5- 8 to enter the ‘Method’ window (As shown in Fig. 5- 9) also.

To delete an existing method, please select the method in the methods table, and then click

the ‘Delete’ button to delete it.

‘Analysis mode’: There are three options: ‘FAAS, FAES, and GFAAS’. the instrument includes
all three options and users can choose one they need.

‘Signal Type’: When using flame method, ‘Transient peak’ and ‘Time average’ can be selected,

and the default is ‘Time Average’; when using graphite furnace method, ‘Peak height’ and ‘Peak

Area’ can be selected, and the default is ‘Peak Area’.

‘Measurement Mode’: There are two options: ‘Standard Curve, Standard Addition’.
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5.3.3 Select the Analytical Element

Click ‘Element’ button in Fig. 5- 9, the ‘Periodic table of elements’ window will be shown in Fig.

5- 10. Select the element to be analyzed and then click ‘OK’ to return ‘Method’ window.

Fig. 5- 10 Periodic table of elements

5.3.4 Instrument Conditions

After selected the analytical element, click the ‘Next’ button in Fig. 5- 9 to enter the ‘Instrument’
window (As shown in Fig. 5- 11). The instrument parameters such as ‘Wavelength’, ‘Slit’,

‘Measurement Time’, ‘Delay Time’, ‘Damping Constant’, ‘HCL Current’, ‘AUX Current’, ‘BG

Correction’, ‘D2Current’ and ‘SH Pulse Current’ can be set in this dialog table.

Fig. 5- 11 Instrument conditions

‘Wavelength’: The default is the primary sensitive line of the element. If users want to use
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the secondary sensitive line instead, click the drop-down menu to select.

‘Slit’: Choose different slit spectral bandwidths according to the analysis of different

elements, the default value is 0.2.

‘Measurement Time’: Indicates the speed of collecting samples. The default is 1, and

users can modify by themselves.

‘Delay Time’: Indicates the time interval from start to peak. The default is 0, and users

can modify by themselves.

‘Damping Constant’: Set the damping constant, it can reduce the noise. For flame

method, it is recommended to select1~3. The default is 1, and users can modify by

themselves.

‘Signal smoothing": During graphite furnace analysis, check this option to automatically

smooth the signal curve on the measurement page.

‘HCL Current’: Select the working current of the HCL decided by different analysis

element.

‘AUX Current’: Tick the option to set the auxiliary cathode current of the

high-performance lamp. Using HPHCL helps to improve sensitivity and detection limit, etc.

‘BG Correction’: Select the mode of background correction between ‘None’, ‘D2 lamp’

and ‘Self-Absorption’. Varies according to different configurations.

‘D2 Current’: Users can choose to input D2 lamp current only after selecting "D2 lamp" in

the background correction.

‘SH Pulse Current’: Users can choose to input SH Pulse current only after selecting "SH

Pulse" in the background correction.

5.3.5 Calibration Equation

Click the ‘Next’ button in the Fig. 5- 11 to get into the ‘Calibration Equation’ window (As shown in

Fig. 5- 12).
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Fig. 5- 12 Calibration Equation

‘Conc. Units’: Set the concentration unit of the samples (ng/mL, µg/mL or mg/mL).

‘Equation’: Users can select the fit one between linear equations and quadratic equations.

‘Pass Zero’: Tick this option to calibrate curve pass through the zero point. S1 should be

entered as calib blank at this time and then input the sample successively. For example, if the

calib point is 1.0, 3.0, and 5.0µg/mL, then S1~S4 should be entered as S1=0, S2=1, S3=3,

S4=5.

‘Calib. Blank’: Tick it means choose the calib. blank. It will automatically deduct the calib.
blank every time when measure the sample.

‘Replicates of Calib. Blank’: Set the measure times of the calibration blank. The average
of the calculation will be engaged in the calibaration equation.

‘Injection Volume’: Set the injection volume when using graphite furnace analysis. The

default of standard samples and unknown samples are 20µL.

‘Standard S1~S10’: Sequence number of the standard solution.

‘Concentration’: Input the corresponding concentration of the standard solution.

‘Replicates’: Enter the number of times to measure the standard solution, and the

average value of the calculation will participate in the curve calculation.

5.3.6 Atomization Conditions

Click the ‘Next’ button in the Fig. 5- 12 to get into the ‘Atomization Conditions ‘window (As

shown in Fig. 5- 13).

Atomization condition has two options: FAAS (Fig. 5- 13) and GFAAS (Fig. 5- 14), and the

condition can be selected automatically based on the analysis source selected when the analysis

method is created.
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Fig. 5- 13 FAAS

Fig. 5- 14 GFAAS

1. FAAS

‘Flame Type’: The instrument which do not expand thermal-flame accessories only support
Air-C2H2.

‘Flue Flow’: Users can select based on the element and conditions they selected referring to
analysis manual.

‘Burner Height’: The distance between the combustion slit of the atomizer and the center of
the optical path.

2. GFAAS

The working process of graphite furnace is divided into four stages: drying, ashing,

atomization and idle running. The drying and ashing can be divided into several steps. The

corresponding temperature, slope, holding (time) are different for different elements, which

can refer to graphite furnace manual. Click the corresponding table and enter the value.
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When tick the Opt. Control, this step will be set as optical control heating; otherwise, it will be

set as constant voltage heating.

NOTE: Optical Control Mode runs only when the temperature exceeds 1800ºC, so that opt.
Control mode can be selected only at atomization and idle-running stage and cannot be
selected at drying and ashing stage.

5.3.7 QC Setting

Click the ‘Next’ button in the Fig. 5- 13 or Fig. 5- 14 to get into the ‘QC’ window (As shown in Fig.

5- 15). This page offers the recalibration function to the calibration curve.

Fig. 5- 15 QC

‘Auto Recalibrate: If select this, recalibration will be inserted automatically to control the sample

quality in the sample table.

‘Recalibrate Interval’: Insert recalibration in the edited sample table after the set test repetition.

‘Recalibrate STD Conc’: Users can input the recalibrate STD conc. either by themselves or

selected one from sample table. Click ‘Select from STD Conc. Table’, an interface is shown as Fig.

5- 16. Select one from the list and click ‘OK’ to return.
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Fig. 5- 16 Select Recalibrate Conc

Fig. 5- 17 Design of Analysis Task

After the entire above are finished setting, click ‘Ok’ button in Fig. 5- 15 to return ‘Method Edit’

window (As shown in Fig. 5- 8). So far it means that the creating of new method is done. Then

click ‘Ok’ button in ‘Method Edit’ window to return ‘Design of Analysis Task’ window (As shown in

Fig. 5- 17).

Project List
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5.3.8 Sample Table

Click the ‘Sample’ button in the Fig. 5- 17 to enter the ‘Sample’ window (As shown in Fig. 5- 18).

Here can set whether to measure the sample blank and its replicates times.

Fig. 5- 18 Sample Table

Click ‘Add’ button can call out the ‘Add Sample’ window in which can add sample. (As shown

in Fig. 5- 19).

Here, you can set the ‘Sample name’, ‘Sample No.’, sample ‘Type’, ‘Intake’, ‘Diluent volume’,

and ‘Replicates’.

Fig. 5- 19 Add Sample

‘Sample Name’: The name of samples, which can be entered as letters, numbers and

Chinese characters.

‘Sample No.’: To order the samples. If the sample name, sampling volume and constant

volume are the same, users can only enter the start and end numbers, separated by commas

",". For example, there are 15 samples in total, after inputting "1,15" and clicking "OK", the

samples are automatically expanded and arranged.

‘Type’: Depend on the liquid state or the solid state of the samples.
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‘Intake’: For the liquid samples, users can select ‘mL’ or ‘µL’; for solid samples, users can

select ‘g’ or ‘mg’.

‘Diluent Volume’: If the sampling volume is 1mL to 50mL, the dilution volume will be 50mL.

‘Replicates’: Set the number of injection measurements for each sample, and the

measurement results will be reported in the form of average.

When the sample table setting is completed, click the ‘Ok’ button in Fig. 5- 19 to return the

‘Sample’ window (As shown in Fig. 5- 20).

Note: Samples cannot be named with the same “Sample name + Sample number”
naming method.

Fig. 5- 20 Sample Table

‘Add’: Users can continue to add samples to be tested after the edited sample

‘Amend’: Amend the sample selected in the table

‘Delete’: Delete the sample selected in the table.

‘Open’: Open a saved sample table.

‘Save’: Save the active sample table.

After edition, click ‘OK’ button in Fig. 5- 20 to return to the ‘Design of Analysis Task’ interface

shown as Fig. 5- 17.

5.3.9 Delete Project

At the page of Fig. 5- 17, select a project in the project table, and then it can be deleted by click the

‘Delete’ button on the right side.

5.3.10 Select Project Samples

Select a project in the project table (As shown in Fig. 5- 17), and then click ‘Project Sample’ button

to enter the ‘Project Sample’ window (As shown in Fig. 5- 21). It can set whether the samples
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are measured in the active project.

Fig. 5- 21 Project sample

5.3.11 Preheat

If the tick box ‘Preheat’ is checked as √ in Fig. 5- 17, the lamp of the next project will be preheated
when the active project is processing.

When all the steps about the design of analysis task are finished, click ‘Ok’ button in Fig. 5- 17

to enter the ‘Working Main Interface’ window (As shown in Fig. 5- 22). It means that the design of

analysis task is finished.

Fig. 5- 22 Working main interface
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5.4 Shortcut Tools

After an analysis task is designed, the user can control, adjust, and optimize the instrument by

the shortcut buttons on the tool bar (As shown in Fig. 5- 23)

Fig. 5- 23 Shortcut Toolbar

5.4.1 Basic Operation

1. ‘New’: Be same as the menu ‘File→New’ to create a new analysis task.

2. ‘Open’: Be same as the menu ‘File→Open’ to open an analysis task.

3. ‘Save’: Be same as the menu ‘File → Save’ to save the present analysis task.

4. ‘Print’: Be same as the menu ‘File →Print’ to print the current displayed page.

5. ’Print Preview’ : Be same as the menu ‘File →Print Preview’ to previse the print.

5.4.2 USB Connect

Turn on the instrument, click button on the tool bar to build communication between the
AAS software and the main unit of the instrument. The instrument can be operated with

various instructions through the computer application software only after the instrument is

connected to the computer.

Note: The hardware initialization and self-check will be performed automatically lasting

about 15s ～ 30s after the instrument is turned on. DO NOT communicate with the

instrument during this time.

5.4.3 Analysis Method

Click the icon in the tool bar to edit the analysis method. The function is same as the menu
‘Tool’’Analysis Method’.

5.4.4 Measure Parameters

Click button on the tool bar can amend the measure parameters, such as measurement
time, delay time and the damping constant (As shown in Fig. 5- 24).
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Fig. 5- 24 Measure Parameters

5.4.5 Task Info

Click button on the tool bar to edit or browse the information refering to analysis task (As
shown in Fig. 5- 25).

Fig. 5- 25 Task Info

5.4.6 Next Project

Click icon to switch to the next testing project after the current project completed.
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5.4.7 Instrument Alignment

Fig. 5- 26 Instrument Alignment

Click button on the tool bar to optimize the working condition of the instrument (as shown
in Fig. 5- 26). The function is same as ‘Tool’’Instrument Alignment’.

‘AA’: Means main light beam. It is used to adjust the negative high voltage (gain) of PMT until the

energy is in the state of 100% more or less.

‘BG’: To display the energy value of the background light source when using S-H method

or D2 lamp method.

‘Auto Gain’: During the operation, if the energy is exceeded or cannot be reached up to

100%, click Auto-Gain to balance it.

Auto balance: Adjust the current of the reference beam and make its energy to balance with

the main light beam.

‘BG Correction’: Users can choose three methods of "None, Deuterium Lamp and

Self-absorption", after the modification, click the setting button at the back to take effect.

‘PMT’: It is used to adjust the negative high voltage of the photomultiplier tube. After the

modification, click the setting button at the back to take effect.

‘Slit’: It is used to adjust the spectrum bandwidth of the instrument, click the drop-down

menu to select, after modification, click the setting button at the back to take effect.
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‘Preheat Lamp’: Adjust the Number and Current of the working HCL and preheat HCL.

And then click their Setup button to send the parameters to the main unit.

‘Reset, Up, and Down’: Click Reset button, the lamp stand will rotate to the starting position
automatically. Click UP and DOWN to manually fine tune the lamp position.

‘Optimize’: The instrument automatically optimizes the current working light position to obtain
the maximum energy after clicking.

Wavelength: Click ‘Wavelength’ button, the instrument will automatically find out the position

around the designated wavelength. Then click - and + of ‘Fine wavelength’ to adjust the

wavelength position, and click Up and Down of ‘Lamp position’ to find out the optimal lamp

position. If the gain (negative high voltage) is too high or too low, input a proper gain value and

click “Setup”, or click “Auto-gain” to make auto-balance.

Auto-wavelength: Click ‘Auto-wavelength’ button, the instrument will automatically seek the peak
value position of the designated wavelength and the optimal lamp position. Simultaneously, the

energy of “Main” should be at 100% more or less to make the negative high voltage of the gain

being matched.

Wavelength scan: It shows the energy distribution of the scanning spectral line in the designated
wavelength range as shown in Fig. 5- 27. Set the "start" and "end" wavelengths and "PMT" in the

"scan parameters”. Click the start scan button to automatically perform a spectral scan in this

range. The scanned map can be saved as a picture (*.jpg format), or it can be previewed and

printed out by clicking the print preview and print buttons.

After the entire instrument alignment was done, click Ok button to quit.

Fig. 5- 27 Wavelength Scan
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5.4.8 Burner Alignment

In the working main interface of AAS with FAAS method, click button on the tool bar to call
out the ‘Burner Alignment’ window (As shown in Fig. 5- 28) to adjust the burner parameters. It

has the same function of menu ‘Tools’’Flame Controller’

‘Flame Type’: Air-C2H2 flame.

‘Flue Flow’: Set the flow of C2H2 according to the different elements and conditions referring

to analysis manual.

‘Air Flow’: It is depending on the pressure regulator.

‘Burner Height’: The distance between the upper edge of the combustion slit of the atomizer

and the center of the light path. Please input it manually.

‘Ignite Flame’: Click this button to ignite the flame of the atomizer. After ignition, this button is

used to confirm the adjustment of the gas flow.

‘Flame off’: Extinguish the Flame.

‘Check’: Check the present condition of AAS.

‘Reset Warning’: Click this button to turn of the alarm sound when the instrument alarms for

abnormal conditions.

‘Close’: Click this button to exit the "Flame Controller" page without affecting the current flame

status.

Fig. 5- 28 Burner Alignment

5.4.9 Atomizer Adjust

Users can adjust the atomizer position of the instrument by click the button in the tool bar. (As
shown in Fig. 5- 29)
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Fig. 5- 29 Atomizer Adjust

Click the Flame Pos or Furnace Pos button to quickly move the integrated atomizer to the

corresponding position, and to fine-tune the atomizer position up, down, front, and back by

observing the changes in the energy received by the instrument.

5.4.10 Furnace

If the instrument adopts GFAAS, click the button in the tool bar to adjust the furnace
atomization conditions. (As shown in Fig). The function is the same as the menu ‘Tools’’Graphite

Furnace Controller’.

Fig. 5- 30 Furnace

‘Step’: Set the conditions for each step of the graphite furnace heating, including temperature,

ramp (heating time), holding (holding time), and whether to adopt light control method for

temperature measurement (only the atomization and idle running stage can choose the optical

control method);



Drawell International Technology Limited

- 48 -

‘Small gas during atomize’: Small drought will be turned on during the atomization stage by
tick this, which can effectively reduce the "tailing effect", but it will affect the sensitivity;

‘Cooling Time’: Set the cooling time after idle running, generally not less than 20s;

‘Cleaning’: Set the temperature and time, and perform a single flush (idle running) on the

graphite tube to remove impurities or residues in the tube;

‘Check/Sent’: Check the atomization condition setting (a prompt will pop up under error

conditions) and click Sent to complete the update of the setting condition after the error is

correct.

‘Heat/Stop’: Click Stop during the process to end the heating process during running the

current atomic heating program.

‘Close’: End atomization condition setting.

5.4.11 Sample Table

You can also edit the sample table during the analysis process. Click button on the tool

bar which is shown in Fig. 5- 31. User can ‘Add’, ‘Amend’, ‘Delete’ samples and ‘Save’ the sample

table.

Fig. 5- 31 Sample Table

5.4.12 Recalibrate

Click button on the tool bar to call out the QC window. Select the corresponding standard
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sample and recalibrate.

5.4.13 Base-line

Fig. 5- 32 Baseline Stability

Click the button to test the baseline stability of the instrument, after the instrument has been
optimized. It has the same function as ‘Tool’’Baseline Stability’.

It is recommended to use Cu HCL at 324.7nm to test the baseline stability. Preheat the Cu HCL for

30 min before the test and optimize and adjust the instrument to the best working condition. Back

to the baseline stability measurement page, set the condition and then click ‘Zero’ to reset the

absorbance to zero. After that, click ‘Start’ to start the baseline stability test.

After the measurement is completed, click ‘Save’ to save the test result directly as a .jpg image

format. The test result can also be printed and preview by clicking ‘Print ‘and ‘Print Preview’ button.

Settings of the Baseline Stability: Click the ‘Setup’ button in Fig. 5- 32, the page will appears as
shown in Fig. 5- 33. The user can adjust the test parameters of baseline stability.

Fig. 5- 33 Baseline Stability Setting
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5.4.14 About

Click the button in the toolbar to display the current version information of the AAS software,
the function is the same as the menu "Help" → "About AAS".

5.5 Analysis Operations

When the analysis task is designed, and all the instrument parameters are aligned the analysis

operations can be carried out.

All the analysis works are operated in the working main interface (Fig. 5- 22). There are five pages

in this window: Analysis, Calibration, Results Data, Signal Graph and Report. Among them, the

"Analysis" tab is the work page for sample analyze, and the remaining four tabs are the

measurement results viewing, data processing, and output pages. Users can check the pages

by click the corresponding label to switch.

5.5.1 Analysis Page

The ‘Analysis Page’ with flame method is shown in Fig. 5- 34, and the ‘Analysis Page’ with

graphite furnace method is shown in Fig. 5- 35. Both include the areas of ‘Graph Display’,

‘Working State’, ‘Absorbance’, ‘Control Button’, ‘Results’. The graphite furnace also includes

‘Step’.

‘Graph Display’: In the area of coordinate system, there will show the dynamic curve of

absorbance-time when sample measuring. The graph parameters can be set by click ‘Set

Graph’ button to call out ‘Graphics setting’ window (As shown in Fig. 5- 36).

Fig. 5- 34 The Analysis Page of Flame Method

Working State

Graph Display

Absorbance

Control Button

Results



Drawell International Technology Limited

- 51 -

Fig. 5- 35 The Analysis Page of Graphite Furnace Method

Fig. 5- 36 Graphics Setting

‘Working State’: Show the measure progressing, reminder the next sample.

‘Absorbance’: Real-time display the absorbance.

‘Control Button’: Click the ‘Measure’ button to start the sample measurement; click the ‘Zero’

button to adjust the absorbance by adding a standard blank or sample blank to the atomizer;

click the ‘Set Graph’ button to adjust the absorption curve axis parameters.

‘Results’: Display the current sample measurement results, and the average of multiple

measurement results, SD and RSD values, etc.

Working State

Graph Display

Absorbance

Control Button

Results

Step
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Take Copper (Cu) as an example, the operation procedure is as follows:

1) Measure the Standard Series

Prepare series of Cu standard concentrations of 1.0µg/mL、3.0µg/mL、5.0µg/mL . Turn on the

air-compressor and the acetylene cylinder and seal the hydro seal in the waste pipe. Ignite the

flame under safe pressure. Then put the sampling capillary into the blank distilled water and

click “Zero” key to make the zeroing adjustment. After zeroing, suck in the standard blank,

1μg/mL, 3μg/mL, 5μg/m Lin sequence according to the reminder of ‘Working State’ and click

‘Measure’ when the absorbance of each sample stable.

2) Check the calibration curve

When the measures of standard series are done, click ‘Calibration’ label to open the

calibration page to check the calibration curve and corresponding parameters, see details

in 5.5.2. The working curve can only be displayed after the standard working points of the

task have been measured.

3) Measure the unknown samples

The measure of the unknown samples is same with the standard series. Users can

reanalyze the unsatisfied or inaccurate samples by operating in the ‘Results Data’ page, see

details in section5.5.3.

4) Measurement finished

When all the analysis works are finished，make sure to turn off the power and gas supply.

5.5.2 Calibration

Click ‘Calibration’ label in the working main interface of AAS to activate the calibration page (As

shown in Fig. 5- 37).

‘Graph Display’: After the measurements of standard series are finished, the calibration curve
will be displayed here.

‘Curve Parameters’: The calibration equation will be shown, correlation index (r), detection

limit (D.L.), and characteristic concentration (C.C.).

‘Project’: Click the drop-down list to check the calibration curve of different projects.

‘Standard Series’: Display the measuring results of standard series. Set the ‘Shield’ check

box as √ can shield the abnormal points selected.
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Fig. 5- 37 Calibration

Amend Conc.: After selecting a certain concentration point, click the ‘Amend Con.’ button to

edit the standard concentration value (Fig. 5- 38).

Fig. 5- 38 Amend Conc.

Add Blank: To add or cancel the measurement and frequency of the ‘Calib Blank’ and ‘Sample
blank’. (Fig.5-31).

Fig. 5- 39 Add Blank

Graph Display

Project

Curve Parameters

Standard Series
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‘Equation’: Select the equation types (Simple: A=K1C + K0 or Quadratic: A= K2C*+K1C+K0).

‘Pass Zero’: Let the calibration curve pass through the zero point.

‘Signal Type’: Select the signal types (Transient peak or Time average).

5.5.3 Results Data

Click ‘Results Data’ label in the working main interface of AAS to activate the results data page

(As shown in Fig. 5- 40). All the measuring results of standard series and unknown samples can

be checked in ‘Results Data’ page. Click the "Project" drop-down menu to switch to view the

measurement data of different analysis items.

Fig. 5- 40 Results Data

Detail: Select one sample in the sample table, then click ‘Detail’ to call out ‘Detailed Data’ window
(As shown in Fig. 5- 41). Users can check the detailed data of selected sample. And the data can

be exported to Excel or printed and previewed (Excel should be installed).
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Fig. 5- 41 Detailed Data

Reanalyze: Users can select a certain sample and click the ‘Reanalyze’ button to remeasure. It
can be redone one of the abnormal points or all of them (Fig. 5- 42). After confirming, return to

the measurement page to continue the measurement.

Fig. 5- 42 Select Reanalyze Points

Delete: The standard series and unknown samples points can be deleted by select them and

then click the ‘Delete’ button. Be careful, for if the data was deleted it will beyond retrieve.

Data Format: Set the number of digits reserved after the decimal point of the data in the record

and calculation by clicking the ‘Data Format’ button.

Excel: The whole results data can be exported in ‘Excel’ format by click the Excel button.

5.5.4 Signal Graph

Click ‘Signal Graph’ label in the working main interface of AAS to activate the signal graph page

(As shown in Fig.5-35). The signal graphs of all the measured standard series and unknown

samples can be displayed here.
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Fig. 5- 43 Signal Graph

The signal graph of each measurement can be displayed in this page. The absorbance signal

spectrum of any measurement can be shown by clicking the sample tree on the right to expand.

The samples that have been tested and those that have not been tested will be displayed in

reverse color.

Click the ‘Set Graph’ button on the upper right corner to setup the graph parameters (As shown

in Fig. 5- 44). It could set the ‘Max’ and ‘Min’ value of displaying ABS and select whether to

automatic or overlay.

Fig. 5- 44 Graphics Setting

‘ABS Scales’: It could set the ‘Max’ and ‘Min’ value of displaying ABS. Select ‘Automatic’ to

automatically adjusted by the software according to the signal diagram.

‘Show Temp’: To display the temperature curve by select graphite furnace method.

‘Overlay’: After checking, click the ‘OK’ button and a check box "□" will appear before each

measurement in the sample tree. Users can select multiple measurement signal graphs to overlap
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and display and compare them in the graph display area.

5.5.5 Report

Click ‘Report’ icon in the working main interface of AAS to activate the report page (As shown in

Fig. 5- 45).

Fig. 5- 45 Report

‘Print Styles’: There are four print styles of the analysis report to choose:

Style 1: Analysis result. Only print the analysis result.

Style 2: Standard curve and analysis result.

Style 3: Sample pretreatment info and analysis result.

Style 4: Standard curve and sample pretreatment info and analysis result.

‘Print Project’: User can print all projects or just print current shown project or print the

projects selected by the check box.

‘Export Word’: Analysis results can be exported to Word documents or printed directly.

5.6 Other Operations of the AAS Software

5.6.1 Electronical Signature

The AAS software provides an electronic signature function (purchased separately), which can

add electronic signatures to the analysis files, and can record and track the operations performed

by each logged-in user on the instrument. For a detailed introduction to the electronic signature
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function, please refer to the supporting instructions in the "AAS Audit Trail Software Instruction

Manual".

5.6.2 Save and Open Files

The analysis task files can be saved as *.AAS* format by clicking the button, and the

saved task files can be opened by clicking the button and find the file save path.

5.6.3 Print and Preview

During the analysis experiment, all five working pages of AAS (Analysis, Calibration, Results

Data, Signal Graph, and Report) can be printed and previewed respectively.

5.6.4 Wavelength Calibration

The instruments has undergone strict wavelength calibration before leaving the factory, and the

wavelength error is within the acceptable range under normal conditions. If the wavelength error

exceeds the allowable range since the optical system is affected by transportation, maintenance

or other reasons, the AAS software also provides us with a convenient wavelength correction

function. The mercury hollow cathode lamp can be used to perform wavelength correction on the

instrument. The operation method is as follows:

1. Open the AAS software to enter the main interface, then click the ‘Communication’ button to

connect with the main unit;

2. Press Ctrl+F10, the icon will be added to the software toolbar, which is a shortcut button
for wavelength correction;

3. Click this button, wavelength calibration window will be popped up;(As shown in Fig. 5- 46)

Fig. 5- 46 Wavelength Calibration

4. A ‘Before Correction’ dialog box will be popped up by clicking the ‘Initialize’ button; (As shown

in Fig. 5- 47)
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Fig. 5- 47 Before Correction

5. After confirming as prompted, click the ‘OK’ button to run the calibration initialization program.

6. Scan the six calibration wavelength points in Fig. 5- 46 above in sequence after the

initialization is completed.

7. After displaying all the scan results, click "Calc. fitting curve" to generate the corrected

"wavelength coefficient K/B". Click "Save Coef." to complete the wavelength calibration.

5.7 Working Process of the AAS Software

The whole working process of the AAS Software is shown in Fig. 5- 48.

Fig. 5- 48 Working process of the AAS Software
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Chapter 6 Maintenance and Service

6.1 Attention for Maintenance

Users may not be familiar with the use of instrument after it has just arrived. Since that, minor

problems that are not malfunctions are often asked for repairs. Therefore, please read the

instruction manual of the instrument in detail before using the instrument, to avoid unnecessary

downtime of the instrument for repair.

In addition, some of the most basic and important precautions are still worth emphasizing before

the user opens the instrument for troubleshooting. In particular, it needs to be pointed out that

some parts of the instrument are difficult to restore once they are disassembled. Users must not

disassemble the instrument without authorization. If there are special circumstances, they must

obtain written permission from the manufacturer. The manufacturer is not responsible for the

serious damage to the instrument caused by the user's disassembly without permission and it is

difficult to repair.

The following should also be noticed when making the maintenance:

1) Do disconnect the power cables before dismantling the instrument.

2) Cut off the water source and gas sources before the maintenance. Close the total valves of all

gases, especially the acetylene cylinder.

3) Do not leave bolts, screws, or other tolls inside of the instrument. Tolls inside the instrument

must be token out.

Notes:

 Do not touch the surface of optical parts when maintaining inside of the
monochromator.

 Never set the high voltage (gain value) of PMT when the monochromator is opened.

6.2 Replacements and Adjustments of Components and Parts

Some parts of AAS are consumables or vulnerable, so they need to be replaced after a period use.

For example, D2 Lamp, HCL, graphite tube, graphite cone, and filter are consumable parts.

Nebulizer, bump ball and burner are vulnerable parts. These parts are easily corrosive, so the

replacement is required. Some of other parts are not consumables or vulnerable ones, but they

will be rusted after working for a long time, such as optical parts, electric parts, etc. Anyhow, the

damaged parts must be replaced. For securing the good performance of the instrument, some

parts should be adjusted after the replacement.
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6.2.1 Replacement and Adjustment of HCL (Hollow cathode lamp)

Hollow cathode lamp is the main light source of the instrument, and its life is generally 5000

mA*hour. Hollow cathode lamps with different elements have different lifetime. In addition, HCL’s

lifetime also depends on working condition. After the hollow cathode lamp reaches its working life,

the performance indicators such as light intensity, spectral line width, and noise value will all

deteriorate, which affects the analytical performance of the instrument and needs to be replaced

with a new hollow cathode lamp.

The replacement of HCL is very simple. Pull up the old lamp from the adapter and plug the hollow

cathode lamp to be used into its adapter and place it into the lamp turret. Keep the light passing

window clean.

Note: The bulge on the HCL connector should aligned to the groove in the lamp holder.

6.2.2 Replacement and Adjustment of D2 Lamp

1) The minimum lifetime of D2 lamp is 500 hours. It should be replaced when its lifetime is over.

During the replacement, the outer dimension must be the same as the original one, and its

working parameters should meet the requirements of the instrument:

Parameters Anode Current

(mA)

Tube Voltage

Drop DC (V)

Filament

Voltage AC (V)

Filament

Current

(A)

Glow

Voltage

DC (V)

Requirements 300 70 10 0.5 ≥200

2) The D2 lamp used in this instrument has four lead-in wires. The red one is anode lead-in wire.

The two black wires are filament lead-in wires, and the yellow one is auxiliary electrode

lead-in wire.

Note: Do not touch the window of D2 lamp by hands. Be careful not to connect falsely
or wrongly when connecting leads.

3) The window of D2 lamp should be aimed at the half-transmission-half-reflection lens during

the installation. The light spot of D2 lamp is very small, so carefully makes the alignment being

light after the replacement. If the light spot position is not adjusted well, it will influence the

energy output of D2 lamp and the light spot overlapping with HCL, and the background

correction will be also affected.

Adjustment method:

① Power on D2 lamp and set the current as about 50mA. Select the slit to be 0.2nm. Power

on Cd HCL with 1.5mA;

② Place a piece of paper in the middle of the burner and observe the light spot of D2 lamp

and Cd HCL on the paper. Adjust the top of D2 lamp holder and side of the screws until the two
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light spots are overlapped.

③ After automatically seeking the peaks, adjust the energy of D2 lamp to make the BG

energy to the maximum. Now the replacement and adjustment of D2 lamp is over.

Note: Be careful that the D2 lamp is very hot!

6.2.3 Replacement of Nebulizer

Nebulizer is the key part of the atomization system. For the flame method, analytical sensitivity

and detection limit greatly depend on the working status of the nebulizer. This part is unique

channel for the sample entering the atomization system, so pipetting capillary, nozzle and impact

bead will be directly corroded by the sample solutions. Wash these parts with de-ionized water

after each analysis. If the instrument works not well, maybe the nebulizer should be replaced and

washed.

Replacement method:

1) Unscrew the four screws on the front of the nebulizer and take off the small bended angle.

Take off the impact bead from the nebulizer slightly.

2) Pinch the metal holder on the back of the nebulizer and take it off slowly. If it needs to be

washed, dip its glass part in acid solution.

3) Install the washed nebulizer or a new one slightly according to the above 2~1 steps.

Notes:

1) When installing the nebulizing nozzle, make sure its neck downward. Otherwise, the
stability of the instrument will be affected.

2) When screwing the four screw of atomization chamber, do not forget the O-rings on the
front cover. The four screws should be screwed equably tightening, avoiding the
flashback.

6.2.4 Replacement of Graphite Tube

Graphite tube is an important component that affects graphite furnace test indicators. Repeated

high temperature burning during the experiment can easily damage the graphite tube. Each

graphite tube has a limited-service life. Therefore, graphite tubes are consumables that need to be

replaced frequently. The steps for replacing the graphite tube are as follows:

1. Under the non-working state, loosen the cylinder knob on the right side of the integrated

atomizer, and nip the right graphite cavity then slide it to the right;

2. Take out the old graphite tube, then clip a new on with tweezers (make sure the injection hole

is upturned) and put it on the left cavity;

3. Align the injection hole of the graphite tube with tooling, then push it back to the right cavity.

After that, tighten the cylinder knob;
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4. The graphite cone will clamp the graphite tube automatically under the action of the cylinder,

then take out the tooling to complete the replacement;

Note: Before using the new tube, idle run the tube about 3~4 times under 2400ºC~2600ºC to
clean and active the tube.

6.3 Daily Maintenance

6.3.1 Light Source

6.3.1.1 Hollow Cathode Lamp (HCL)

1) Carefully install or detach HCL to avoid breaking. Keep the light passing window clean. If oil

stain or fingerprint dirties the window, the light energy emitted from the cathode will be

decreased, especially the energy of the short wave. To clean the oil stain, wipe the window

with absorbent cotton dipped with alcohol-ether mixture solution (ratio 1:3). Hold the lamp

holder when taking the lamp up or down;

2) HCL cannot be placed without using for a long time. Otherwise, it will not be ignited or used

abnormally because of gas leakage, gas absorption or release. The rarely using HCLs should

be powered on for 2~3 hours every 3~4 months. It is very important for avoiding the batch

obsolescence. The user should pay enough attention to this, otherwise the lights will be

scrapped in batches. If they can't be lightened, positive and negative polarity reverse

activation method can be used to settle this problem. According to the characteristics of

hollow cathode lamps, it is recommended not to buy hollow cathode lamps that are not used

prematurely;

3) A lamp removed from the lamp holder should be put into the lamp box in time. Please do not

put it in random, and do not mix it with various steel tools to avoid cracking or scratching the

glass of the hollow cathode lamp shell;

4) If the HCL is broken, the cathode substance will be exposed. Some element materials are

harmful to human body, so they should be processed according to standard laboratory

method.

6.3.1.2 D2 lamp

1) The lifetime of D2 lamp will be shorten if it is frequently powered on and off.

2) Do not touch the light passing window with fingers. After the replacement, clean the window

with the absorbent cotton dipped with alcohol-ether mixture solution, and then power on the

D2 lamp.

6.3.1.3 Rotating Lamp Hanger

1) Under the working state, lamp is switched by the lamp hanger that is rotated by the precision

shaft holder which is driven by motor. Do not pull the lamp hanger by hand when it is
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electrified.

2) It is recommended to fix the lamp position for long term analysis in order to reduce the

frequency of disassembling lamp and time of optimizing the lamp position.

3) Put down of the lamp room door in time after shutting down to minimize dust falling into lamp

room.

4) During regular maintenance of the instrument, use a cleaning cloth to wipe off the dust and

stains in the lamp holder, socket and lamp compartment.

6.3.2 Optical System

6.3.2.1 Attention

Moisture-proof and dust-proof in the laboratory is a necessary condition to extend the life of the

optical system. Since the optical system is expensive and moisture-sensitive optical components

cannot be restored after damage, the main components of the optical system are sealed and

protected. The user should not touch the exposed optical parts (such as the lens) and do not

remove the cover at will.

6.3.2.2 Outer light path

1) Always pay attention to the cleanliness of the lens. If there is dust on the surface, users can

blow it with a clean blower. If there are fingerprints or other stains, use absorbent cotton

dipped in a suitable amount of ethanol and ether mixture to wipe gently. Be careful not to

scratch the surface.

2) The lens used in the instrument is an achromatic lens, which is precisely assembled and is

difficult to restore after disassembly by non-professionals. Do not disassemble the lens unless

necessary.

3) The beam joiner in the lamp chamber is constructed by aluminized half-reflection lens. The

lens must not be touched with the fingers or wiped with anything.

6.3.2.3 Monochromator

1) The monochromator is located on the right side of the upper part of the instrument and is

sealed by a special cover. It is a precious and precise part that needs to be protected from dust

and moisture;

2) Do not open the monochromator closure without authorization. If you confirm that the

spectroscopic system is malfunctioning, please contact the manufacturer first, and a

professional will handle it;

3) If it is confirmed that the sealing cover needs to be opened to view the internal conditions of

the monochromator, please comply with the following requirements:

a. Set the PMT high voltage as 0V;
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b. Make sure the lab is in a dry, clean and closed environment, and close the exhaust

pipe system above the instrument;

c. The checking person must wear work caps and masks and should hold their breath as

much as possible. Do not talk to other persons, so as not to stain the grating and

reflector with saliva and gas in the mouth;

d. If there is dust on the surface of the reflector and grating, you can gently blow it with a

clean and dry blowing balloon;

e. If there are slight stains or mildew on the surface of the reflector and grating, you must

contact the manufacturer for replacement and repair. It is absolutely forbidden to touch

the surface or wipe with lens cleaning paper or absorbent cotton.

Note: After opening the monochromator cover, do not touch the grating and reflector! Don't
wipe it with anything! If the surface of the optical parts in the monochromator is
contaminated or other conditions, please contact the manufacturer to solve it!

6.3.2.4 Graphite Furnace System Temperature Measurement Part

1) Graphite furnace temperature measurement light route composed of lens, filter and

photosensitive element, which is located on the left side of the integrated front part of the

instrument and facing the graphite tube;

2) The position of the optical element in the temperature measurement optical path is related to

the correction of the graphite furnace temperature curve so the system must be calibrated with

a special temperature measurement device. Do not move the temperature probe assembly

and the temperature probe bracket during maintenance;

3) When dust or graphite powder falls on the surface of the temperature measuring optical

element, a clean blowing balloon can be used to blow off the dust;

4) When the surface of the temperature measuring optical element is stained with other stains,

be sure to dip a suitable amount of a mixture of ethanol and ether with absorbent cotton to

remove slight stains without disassembling the device. Be careful not to scratch the surface;

5) If it is confirmed that the temperature measurement probe assembly or bracket is loose or the

position is moved, please contact the manufacturer to solve it. Users must not fix or adjust by

themselves so as to avoid abnormal graphite furnace temperature control system, which may

cause danger.

6.3.3 Atomization System

Samples to be analyzed are corrosive in generally. For a long time use and high performance of

the instrument, the atomizers should be maintained regularly.

The flame atomizer is composed of nebulizer, atomization chamber, burner and so on. The sample

will pass through the system during testing, so each part is in an acidic environment for a long time.
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For this reason, the user is required to routinely clean the system after each use and should be

maintained regularly.

6.3.3.1 Daily Cleanness and Maintenance

1) Do the following steps after a batch of samples are analyzed: ① Keep the flame on and spray

the de-ionized water for about 10 minutes. Thus, it can remove the left samples in the

analyzing system. ② Clean the overflow sample drops, especially organic drops. ③ Pour out

the waste liquid in time.

2) Routine Maintenance. Clean the nebulizing burner system weekly, including the nebulizer, the

atomization chamber and the burner. If the analyzed sample has a high concentration or a

turbid solution, it should be cleaned once a day after the analysis is completed.

3) After using organic phase spray, or spray high concentration of Cu, Ag, Hg and other salt

solutions in the air-acetylene flame, do clean them just after the analysis, because the

unstable acetylene which is detonable will be generated. The clean method of the organic

solutions is: ① spray the organic solution with sample mutually dissolved for about 5 minutes;

② spray acetone for about 5 minutes; ③ spray 1% HNO3 solution for about 5 minutes; ④

spray de-ionized water for about 5 minutes.

6.3.3.2 Maintenance of Nebulizer

1) After the daily operation, the nebulizer should be cleaned. For samples with high or low PH,

users should prolong the cleaning time appropriately;

2) The maintenance period depends on the characteristics of samples and the quantities of tests.

With low consistency and small test tasks, the period could be 7~10 days. With high

consistency or turbidity and frequency, the period should be telescoped appropriately;

3) The metal sleeve glass sprayer of this instrument is delicate and fragile. The sprayer seat is

made of acid-resistant non-metallic materials with hard texture, but the inferior ability

withstands cold shock at the edge. Please handle with care, don’t bump or fall off;

4) If the front of the capillary in the nebulizer is blocked up, do not poke it with metal silk which will

damage the glass parts. The methods of removing the stem are that blow the capillary in the

negative direction or pump it inversely. For the organic stem, take off the nebulizer from its

holder and dip its front in the potassium dichromate solution to dissolve the block.

5) After a long time use, if the sediment occurs in the nozzle of the nebulizer, the spraying

quantity will be decreased and the sensitivity will be affected. In this instance, take off the

nebulizer and clean the nozzle.

6) If the plastic absorbing capillary is bent that cannot be used anymore, heat it up in the hot

water. Then make it straight and cool it down.
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6.3.3.3 Maintenance of Burner

The flame from the long slot of the burner should be steady and well-proportioned. If the flame

shows vary obviously and irregularly for a long time, there should be some sediment in the slot.

The clean method is:

1) Under the assembled burner, blow it with the air compressor and scratch the slot sides

carefully with single side blade that blow off the deposits by air. Do not damage the slot sides.

Also, users can clean it with corrosive soapsuds.

2) Hold both ends of the burner and turn it upwards to remove the burner. Put the burner into the

ultrasonic cleaner for cleaning or soak the burner into 5% HNO3 solution for eight hours and

then brush off the dirt. After cleaning, rinse with deionized water to dry, and reinstall it in the

reverse order of removal.

6.3.3.4 Maintenance of Atomization Chamber

1) The atomization chamber is made of acid-resistant non-metallic materials with hard texture,

but the inferior ability withstands cold shock at the edge. Same as the maintenance

requirements for nebulizer, the regular maintenance period is determined based on the nature

of the analysis sample and the amount of analysis tasks;

2) Take off the burner head and pour 50mL de-ionized water into the upper neck of the

atomization chamber. Let the water flow out through the waste liquid pipe. Repeat this step for

several times;

3) If the atomization chamber is still not clean, dismount it and clean it with surface-active agent

solution, and then wash it with the de-ionized water;

4) The inner wall of the atomization chamber should be cleaned with water or solvent, and do not

scratch with metal or hard objects. If the instrument will be not used for a period of time, the

atomization chamber should be cleaned;

5) The connection between the atomization chamber neck and the burner head is sealed by

O-rings. When dismounting the burner head, please turn it slowly and pull it out in the direction

of the atomization chamber neck. Do not overexert it strongly to avoid damaging the neck.

Note: Do not jerk or wrest the atomization chamber and its holder hardly. Disassemble the
atomization chamber holder carefully and slightly. Avoid bumps!

6.3.4 Graphite Furnace Atomization System

The graphite furnace atomization system of the instrument is composed of furnace, water and gas

supply control system, and graphite furnace power (external). The furnace connects the power

with a special cable. The graphite furnace is a sealed top longitudinal heating structure. Dust and

residual samples must not be left in the graphite furnace during analysis.

The maintenance of the graphite furnace system should be based on the analysis of the use
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situation. Observe the loss of graphite tube, the corrosion of the graphite cone, the pollution of the

quartz window, etc. momentarily, and carry out the cleaning and maintenance in time.

6.3.4.1 Maintenance of Graphite Tube

The service life of graphite tubes affects by the atomization temperature (main effecter), flowrate

of carrier gas and shielding gas, characteristics of sample, PH of the solution, and so on during the

analysis. The optical use time vary greatly from dozens of times to hundreds of times. For the daily

maintenance of graphite tube, using high temperature atomization to idle run for 1~2 times after

each analysis task is completed. If it is observed that the pyrolysis layer in the middle of the

graphite tube is basically ablated or burned, which is reflected in the significant decrease in the

sensitivity and precision of the measurement data result, the graphite tube needs to be replaced.

6.3.4.2 Maintenance of Graphite Cone

The graphite cone is installed on the right and left stand of the graphite furnace. For the daily

maintenance of a graphite cone, the 90-degree cone should be maintained and kept smoothness

and gloriousness. If the graphite tube is not in close contact with the graphite cone that sparking

occurs when the power is turned on, the graphite tube should be taken out to observe whether the

surface of the graphite cone is knocked out of pits or humps. If the surface of the cone is rough,

use a finer piece of sandpaper to burnish it. While the cone is severely rough and cannot be

renovated, a new cone should be replaced.

6.3.4.3 Maintenance of Sealing Windows

Both two sides of the furnace are sealed by quartz windows with high light transmittance. The

windows are installed in the sealed white stand. Windows should be kept clean and desiccated.

The maintenance methods are: observe the windows whether they are clean with the inspection

glasses outfitted with the instrument. If there is contamination, take off the sealed windows and dip

a mixture of ethanol and ether with clean absorbent cotton to gently wipe the contamination, then

dry the windows and put them back to the stand. If the pollution is serious, users can unscrew the

Teflon nut in the sealed window seat, take out the windows, clean them, and install them back on

the sealed window seat.

For more detailed maintenance, and parts replacement methods for the graphite furnace system,

please refer to the graphite furnace system instruction manual.

6.3.5 Gas and Water Supply System

The internal gas and water supply systems in the instrument are consisted with flame gas supply

module and graphite furnace water supply module separately.

The external gas supply module of the flame method includes an air compressor, an acetylene

cylinder and gas pipes. For the graphite furnace methods, an argon cylinder, a water cooling

circulate system and relative pipes are added. Routine and regular maintenance work should be
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carried out on the water gas and water system of the instrument.

6.3.5.1 Gas Supply Module of Flame Method

The flame gas circuit module is composed of two parts: the gas supply control unit (pipe color is

orange red) and the auxiliary gas supply control unit (pipe color is blue). The maintenance of this

module should be noted that:

1) The use time of the filter is related to the cleanliness of the gas used. If the filter is found to be

clogged, replace a new one. Use a wrench to remove the joints and air nozzles at both ends

of the old filter and install them on both ends of the new filter. Note that the installation

direction should be the same, and do not miss the gasket in the joint;

2) The mass flow controller is a precision device, and it is expensive. Using gas whose purity is

lower than required will cause blockage and damage to the device. While users cannot repair

the blocked controller, they should contact the manufacturer for replacement;

3) Pay attention on the water storage condition of the pressure regulating filter during the

operation of the instrument. The filter can drain automatically. If the water cannot be released

when it exceeds the max storage volume, check whether it is faulty and repair it.

6.3.5.2 Gas and Water Supply Module for Graphite Furnace Method

The gas and water supply system of the instrument is composed with carrier gas and shielding gas

supply control unit (black pipes), cooling water supply control unit (transparent pipes). Under the

condition of using inert gas purity that meets the requirements, the module does not require

special maintenance. But it should be checked regularly for leaks, water leakage, etc., and

repaired in time.

6.3.5.3 External Gas and Water Supply System

1) Check the gas leakage of the pipes, valves and connectors regularly. If there is the gas

leakage, repair or replace it immediately. If the air compressor, circulating water machine or

pressure reducing valve for air source fails, please contact the manufacturer for repair;

2) Check if there is water in the loop of the air compressor regularly. If so, drain it off in time.

Drain off the water in the gas-water separator frequently to avoid the water entering into the

instrument;

3) Check the pressure of acetylene cylinder before the flame method frequently. For the

air-acetylene flame, replace a new cylinder if its pressure is less than 0.3Mpa. Otherwise, it is

easy to cause the acetone in the cylinder to escape, which affect the flame state and reduce

the flame temperature, or even block the internal precision components of the instrument that

may causing economic losses or safety issues;

4) After using for a period, if the pressure loss of the gas piping of the acetylene is larger than

0.03MPa, the inlet filter of the acetylene should be replaced.
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5) For graphite furnace method, a new argon cylinder should be replaced if the old one’s

pressure is less than 0.5 MPa;

6) While using a cooling circulating water machine (deionized water must be filled), the

discolored and turbid deionized water should be replaced regularly. If the machine stops

working for a long time, drain the water in the pipeline.

6.3.6 Circuit System

1) If the instrument will be unused for a certain time, it should be powered on regularly to avoid

the damage to the circuits. Especially in humid areas, users should pay more attention to

frequently power on the instrument to prevent the circuit system from being damp and moldy,

causing short-circuit failures, circuit components corrosion, etc.

2) For the instrument often used, the dust on the circuits should be cleaned regularly. Cleaning

method is pulling the circuits off and blow them with rubber ball or remove the dust with soft

hairbrush. After cleaning, install them as the original appearance. Ensure that plug those

cables and connectors rightly.

Note: It is forbidden to place the instrument in the chemistry laboratory, reagent room or
sample pretreatment room! Because the acid gas and other corrosive gases in the above
room will cause very serious and irreparable damage to the circuit system of the
instrument in a short time!

6.4 Trouble Shooting

6.4.1 Treatment with Emergency

6.4.1.1 Suddenly Power Off

In this instance, switch off the instrument, computer, and other devices rapidly, and cut off all the

gas sources. When everything is OK, restart the instrument according to the operation

procedures.

6.4.1.2 Abnormal Flame Color

The normal color of the air-acetylene flame is light blue. When the flame color abnormal,

immediately extinguish the flame through the software, or press the emergency stop button to turn

off the gas, or directly turn off the instrument host. The abnormal flame is usually caused by the

pressure of the gas source, the abnormal purity or the blockage of the acetylene filter. After

purging the gas, ignite it again.

Abnormal Graphite Furnace

In this case, click stop through the software reading page immediately, or directly turn off the

graphite furnace power supply accessory. The normal sound of heating the graphite furnace

should be a gentle "buzzing" sound of the heating current. The abnormal temperature control of
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the graphite furnace is usually caused by an error in the control signal of the graphite furnace or an

abnormal communication between the instrument/power supply and the host computer. After

eliminating the fault, increase the temperature again.

6.4.2 Common Troubleshooting Analysis

6.4.2.1 Communication Fail

Troubles Reasons Solutions

No power

Abnormal external power

supply of the instrument

Check whether the power supply and wiring of

the laboratory are normal

Check whether the main unit is powered on

Check whether the cable and the fuse are break

or have poor contact

Abnormal internal power

supply

Open the rear panel of the instrument. Check

whether the power supplies of +5V、±15V、+24V

on the circuit board are working properly.

Poor contact of cable Shut down and unplug the cable, replace the

power socket or use pliers to clamp the three

contact pins in the power socket to make good

contact

No

communication

(Each board

unable

contact)

Abnormal power Check whether the instrument is powered on

Abnormal USB line Check whether the USB line between main unit

and computer is connected well

Improper communication

timing

The instrument is automatically initialized and

self-checked after power-on, please wait for the

end of the process (15s～ 30s) and then click
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communication

Power failure inside the

instrument

Open the rear panel of the instrument. Check

whether the power supplies of +5V、±15V、+24V

on the circuit board are working properly

6.4.2.2 Energy is too low.

6.4.2.3 Troubles of hollow cathode lamp

Troubles Reasons Solutions

No light.

Lamp power supply is

damaged or not connected

well or Fuse is damaged.

Check if the lamp power board is

normal. Check the connections of all

sockets.

Lamp has gas leakage. Replace a new lamp.

Troubles Reasons Solutions

Low energy

Emission of hollow cathode is

weak.

Replace a new lamp. User can compare it

with other element HCL firstly

Atomizer blocks light Check whether the light path is blocked,

correct the position of the atomizer

Optical system is not adjusted

well.

Re-adjust the optical system and make the

light spot just aimed at the incidence slit.

Lens is polluted seriously. Clean the lens with alcohol-ether mixture

(ratio 1:3) or replace it.

Slit or optical parts are dirty. Clean the optical parts or replace them.

Performance of HV module is

decreased.

Replace it.

Large

wavelength

error

Wavelength shift occurs when the

instrument is installed recently or

used for a long time

Re-adjust the parameters
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Troubles Reasons Solutions

Only emit light from

the outside of

cathode; low

measuring line

energy;

Pressure intensity of inert gas

is decreased too low to

support the normal discharge.

Replace a new one.

Glowing color is

normal, but energy of

analyzing line is too

low, even hardly to be

detected.

For long time use, the

cathode metal is exhausted

or the radiation intensity of

weak light elements (As, Te,

Se, Bi, Sb, TombarThite ，

etc. ) is too low.

The lifetime of lamp which cathode

metal is exhausted is ended. Replace a

new lamp.

Select the lamp with big intensity

instead of weak light elements.

Sensitivity is lower

during determination.

Emitting background of lamp

is too large.

Replace a lamp with low emitting

background if the low sensitivity is

caused by the lamp.

Light from the lamp is

very strong and lamp

current is also very

large.

Lamp circuits have problems. If only one lamp has this problem,

replace the light source driver board;

If all lamps do so, replace the light

source substrate;

Check the ±15V, +5V on measuring

main board.

The tails of anode

and cathode in the

lamp tube is shining.

Poor shielding between

cathode and anode, so that it

is breakdown by large current

Replace a new lamp.

The light suddenly

goes out during the

test

Undetected power outage Shut down the instrument and restart.

6.4.2.4 Flashback occurs

Troubles Reasons Solutions

Flashback No water seal at draining outlet of Add a water seal.
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Troubles Reasons Solutions

occurs during

testing with flame

method

waste liquid.

Explosion-proof membrane is broken Replace the explosion-proof

membrane.

Burner slit was widened. Replace the burner. (Slit width

<0.7mm)

Oxygen content in air cylinder is too

large.

Replace a appropriate air cylinder.

Note: Once flashback occurs, check if the explosion proof film is damaged. Plug the intact
explosion proof plug into the back of the nebulizing chamber. Also check if the nebulizer
and burner are damaged. If all are ready, may ignite it again.

6.4.2.5 Instrument is unstable

Troubles Reasons Solutions

When not firing

the instrument is

unstable; after

changing the

lamp the

instrument is still

unstable

Incorrect wavelength Correct relative parameters

The grid voltage fluctuates greatly Add regulated power supply

The power supply is not well

grounded

Use copper broad to ground directly

HV module output is unstable Replace a new HV module

Poor contact components in the

circuit

Check each chip and plug carefully

after shutting off

Damaged components in the circuit Ask manufacture for repair

Surrounding strong magnetic field

or high frequency interference

Keep away from the source of

interference

When not firing

the instrument is

unstable, after

replacing the

lamp the

instrument switch

Emission intensity is low and

negative HV is set too high.

Increase the lamp current.

Widen the slit.

Replace a new lamp

Lamp emission is unstable and Replace a new lamp
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Troubles Reasons Solutions

to stable lamp background is large.

The instrument is

stable when it is

unfired. Ignite the

instrument and

stop spraying, it

becomes

unstable

Combustion gas is not pure. Purify it

Combustion gas is unstable. There may be gas leakage in output

pipes of acetylene cylinder. Or C2H2

flowmeter is bad.

Ratio of combustion gas is too big

and flame emission is large.

Use smaller band pass (narrow slit).

Air is unstable. Replace a new air flowmeter.

Burner position in optical path is

incorrect.

Adjust the burner up or down, front or

back and turning angle

Flame absorption is big in

short-wave zone.

Use background corrector. Verify it

with Cu or Mg lamp

The instrument is

stable when

ignited and

sprayed, and the

instrument is

unstable when

ignited and

sprayed

Impact bead position is changed. Shut off the flame and re-adjust impact

bead. Making the fog uniformly

forward when spraying.

Capillary tube is blocked. Blow it with air compressor or clean it

with clean liquid or replace a new one.

Waste tube is blocked Clean it or replace it.

Nebulizing chamber is polluted

seriously.

Wash it with acetone, HNO3 and

de-ionized water.

Strong emission of solution

compounds occurs in the flame.

Remove these components by

chemical method.

Nozzle corroded severely Replace it.

Burner head is blocked See the section 6.3.3

There is water stocking in pipes or

nebulizing chamber.

Waste liquid is full and pour it out in

time.
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6.4.2.6 Problems with the result.

Troubles Reasons Solutions

Calibration

curve doesn’t

pass through

zero point.

When preparing the samples, the

agent or solvent used is polluted.

Re-prepare the sample solutions.

Calibration curve bended Use the quadratic equation to fit the curve

The calibration curve is not linear Re-prepare the sample solutions.

Sensitivity is

low

Flame property is not right. Refer to the concerned manuals.

Flame position is not right. Adjust the burner up or down, front or back

and its turning angle.

Nebulizer is not good enough and

spray efficiency is too low.

Adjust the position of impact bead or

replace a new one.

Lamp current is too large. Decrease the lamp current to improve the

sensitivity but will affect the stability.

Slit is too wide. Choose the proper slit according to

analysis manuals.

Nozzle is blocked up and

sampling flow volume is too low.

Clean the nozzle or replace a new one.

Sample concentration, vapor

tension or matrix concentration

too large.

Properly process the samples and change

their physical properties.

Detection limit

is unqualified

Integral time is not long enough. Increase the integral time.

Sensitivity is too low. Solve it referring to the above table.

Noise is big. Increase the lamp current properly

Spray is unstable. Check the nebulizer.

Results are

comparatively

low.

Matrix or chemical interference

exists.

Verify it with standard solutions and

process the samples to remove the

interference.
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Standard solution is prepared

inaccurately or polluted.

Verify it with other element standard

solution and re-prepare it.

Sample concentration is

decreased because of container

absorption.

Verify it with other element solution and

re-prepare it.

Blank solution is polluted. Prepare new blank solution.

Results are

comparatively

high

Blank reagent has not been used

for the calibration.

Use the blank reagent to calibrate the

result again.

Ionization interference exists.

Standard solution is prepared

inaccurately

Re-prepare standard solution, adding

de-ion agent or ionization proof agent.

Method is not properly. Change other wavelength, use background

corrector or higher temperature flame.

Results drift

Light intensity of HCL keeps

changing.

Replace a stable lamp or auto-adjust the

zero.

Frequently adjust lamp current. Pre-heat ten minutes after changing the

lamp current.

Burner is not pre-heated enough. Prolong the pre-heating time for 3~5 min.

Capillary is blocked up or

corroded.

Clean it or replace it.

Waste liquid flow is not smoothly. Check and fix it.

Gas supply system is unstable. Check if there is water in pipes or if the gas

source is stable.

6.4.2.7 Troubles of background corrector

Troubles Reasons Solutions

D2 lamp is not Lamp is breakdown Replace a new one.
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lit Glow voltage increases after long

time use.

Replace a new one when it can’t glow.

Trouble in power supply circuit. Measure the voltages of the four wires of

D2 lamp. Voltage of red wire to Earth is

about DC200V, and voltage between two

black wires is about AC10V.

Setting of the software is not

correct.

Set “reference signal to be D2.

D2 lamp

energy is low

Light spot of D2 lamp has not been

entered into the optical path.

Re-adjust the position of D2 lamp.

Wavelength range used is not

correct.

The short-wave range should be used for

D2 lamp (<300nm).

D2 lamp is breakdown after long

time use.

Replace a new one.

Noise is large

when using

hack ground

correction

Energy of D2 lamp is low, so that

HV(Gain) is too high.

Adjust the energy of D2 lamp and

decrease the high voltage. If the energy

cannot be adjusted any more, the slit will

be widened.

Damps of both background

correction circuits are small.

Set proper damping

Background

correction

effect is not

good enough

Electric balance is bad. Customer cannot adjust it yourself and

contact the manufacture for help

Optical balance is bad. Re-adjust the positions of D2 lamp and

HCL and make the two light spots

overlapped.

Concentricity of light spot of HCL is

bad.

Rotate hollow cathode lamp to seek the

overlapping position of both light spots.

Atomization temperature is not

proper.

Select proper atomization conditions



Drawell International Technology Limited

- 79 -

Troubles Reasons Solutions

Background value >1.0A(D2 lamp

background correction method);

Background value >1.8A (S-H

method).

Exceed the background correction

capability, process the sample twice or

optimize the atomization conditions to

appropriately reduce the background

value.

6.4.2.8 Instrument Alarm

Troubles Reasons Solutions

The alarm sound

continues

Gas sensitive circuit alarm Strengthen indoor ventilation,

eliminate indoor irritating gas

interference

The alarm sounded a

little longer and

paused

Pressure sensitive circuit alarm Check whether the air compressor is

working properly and whether the

pressure is sufficient

The alarm is short Photosensitive circuit alarm Check whether there is strong light

irradiated or blocked at the

photosensitive probe

Alarm when power on Gas-sensitive alarm,

environmental conditions

change the parameters of the

instrument

Record the details and consult the

manufacturer’s technical staff

Alarm lamp is on

when powering on the

instrument.

Gas sensor alarm. Instrument

parameter is changed caused

by the environmental changes

of the instrument.

Recorder the situation details, Consult

factory technical personnel.

Alarm when Igniting

failure.

There is air in the acetylene

pipes.

Re-ignite for more times to remove all

the air from the pipes.

Instrument parameters are

changed.

Adjust according to the testing

software.

Air pressure is not big enough. Adjust outlet pressure to no less than
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0.2MPa.

Light sensor alarm. Adjust according to the testing

software

After ignition for a

while, the flame is off,

and the alarm is on.

Acetylene leakage exists in the

piping.

Check the piping and connectors with

soap water.

Igniter cannot ignite

the flame.

Igniting needle is oxidized after

a long-time use.

Clean the igniting needle with

sandpaper.
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Appendix A Software Data Processing Instructions
The instrument is equipped with special analysis software. Users need to install this software on the
computer before they can operate the instrument normally. The instrument states is controlled and
optimized through this software, and also it supports multi-tasks analysis. The software has automatic
data processing and calculation functions, which can automatically fit the working curve, reset the
slope, calculate the concentration, calculate the sample content, etc. Meanwhile, it has an electronic
signature function to ensure the traceability of the data results.

The data processing content in this software, such as the calculation of absorbance, the calculation of
slope and intercept in linear regression, the calculation of data detection limit and relative standard
deviation, etc., are strictly in accordance with "JJG 694-2009 Atomic Absorption Spectrophotometer
Verification Regulations" for data processing and calculation.

For the contents that are not provided in the regulation, they will be explained here.

A. Absorbance Calculation

According to the "2 Overview" in the verification regulations, the relevant data in this software is
processed and calculated as follows:

Atomic absorption spectrophotometer is an instrument for quantitative analysis based on the degree
of absorption of characteristic radiation by the ground state atoms of the measured element. The
measurement principle is based on Beer-Lambert's absorption law:

� =− lg �
�0

= − ��� = ���

Where: A––Absorbance

I0––Intensity of incident light

I––Intensity of transmitted light

T––Transmittance

k––absorption coefficient

c–– The concentration of the measured element in the sample

L–– the light path through the atomizer

B. Slope and Intercept Calculation in Linear Regression

The relevant data in this software is processed and calculated according to the content of "Appendix
A" in the verification regulations.

a. Liner equation: � = � + ��

b. Slope: � = ���
���

c. Intercept: � = � − ��

d. Correlation coefficient: � = ���

������

Where: SCC = c2 −� ( c� )2

n
, SII = I2 −� ( I� )2

n
, SCI = cI −� c� I�

n

I––response value
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b––the slope of working curve

a––intercept of working curve

c––concentration of standard solution

r––liner correlative coefficient

n––the number of standard curve points

C. Calculation of detection limit and relative standard deviation

Process and calculate the relevant data in this software in accordance with the content of "5 Control
of Measuring Instruments" in the verification regulations.

a. Sensitivity: � = � (flame method), � = �/� (graphite furnace method)

b. Standard deviation: sA = i=1
n (I0i−I0� )2�

n−1

c. Detection limit: CL = 3sA b (Flame method), QL = 3sA S (Graphite Furnace
Method)

d. Relative standard deviation: RSD = 1
I�

i=1
n (Ii−I�)2�

n−1
× 100%

e. Each concentration point Inverse: ci = Ii�−a
b

Where: b—The slope of the working curve

a—Intercept of working curve

V—Sampling volume

n—Number of measurements

I0i––single measured value of the blank solution

�0––The average value of blank solution measurement

Ii––single measure value of standard solution

��––average of each point

D. Other Instructions

For the contents that do not be regulated in "JJG 694-2009 Atomic Absorption Spectrophotometer
Verification Regulations", they are regulated in this software according to Chinese laws.

For those that do not be regulated both in the Verification Regulations and Chinese laws, they are
regulated according to product enterprise standard.

a. Standard Concentration: The absorbance value of the standard point that calculated by the
software, and the absorbance value of the standard blank has been deducted;

b. Actual Concentration: The actual concentration of the sample point that calculated by the
software, and the blank concentration has been deducted;

c. Data digits: The data display and calculation digits in the data sheet and working curve page
are shown in the following table.
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Types
Decimal Places

Default Setting

Data sheet

Absorbance 4 1~6

Standard Deviation 6 1~6

Relative Standard Deviation 4 1~6

Inverse Concentration, Actual

Concentration
4 1~6

Linear Correlation Coefficient 6 —

Detection Limit 6 —

Characteristic Concentration,
Characteristic Quantities 6 —
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